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Unit 
Syllabus 

Unit - 1  
Computer Fundamentals Definition Generation & Basic Components of Computer , 
Input / Output Device , Memory & Other Peripherals , Introduction to Operating System 
( Windows 98 / X ) , Function & feature of Operating System ( Accessories , Control 
Panel , Desktop , understanding file and folder properties )  

Unit -2 Office Automation Tools : MS Word- Introduction to MS Office Suit , Introduction to 
Word Processing . Tool and Menu Document editing , working with tables , images and 
word art ( creating flow chart ) , header footer , inserting page number date and time . 
Working with image in word. Creating research and scientific documents - references , 
table of contents , insert index , table of figures , cross references , bibliography , mail 
merge  

Unit -3 Office Automation Tools : MS Excel & MS Power Point MS Excel Interface , Tools & 
Menus , Creating Spreadsheet , Use of Function Charts & Graphs , data Analysis tools ( 
T - test- F - test , Anova Test ) . MS Power Point Interface, Tools and Menus Creating 
Slides , Inserting Multimedia Objects , Transitions and Custom Animation , Delivering 
Presentations introduction to Google docs , Google drive , Google forms . Google scholar 
, Google power 

Unit -4 Internet Technologies and research tools Introduction to various social media 
platforms face book twitter , LinkedIn , blogs , Instagram , YouTube etc. Social media 
research tools - twitter Face book analytic Instagram business tools , YouTube analytics 
. Search Engine Optimization ( SEO ) , Social Media Optimization ( SMO ) and Search 
Engine Marketing ( SEM ) : Concept , Difference and Functioning Web scraping . Search 
Engines Concept . Types , Crawler based and Human power directories , Different 
search engines available . Search Engine as a Tool of research .  

Unit -5 Info graphics- Introduction to info graphics , Visual Elements of Info graphic - Info 
graphic Colors , Info graphic Fonts , Info graphic Icons , Info graphic Images . Types of 
info graphics - Informational Info graphic , Timeline Info graphic , Charis Info graphic , 
Comparison Info graphic , Number Info graphic , Resume Info graphic . Process of 
creating info graphics , Info graphic -Tools - open - source and - free online tools to 
create info graphics .  
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UNIT -1 

Introduction 

A computer is a general purpose device that can be programmed to carry out a set of arithmetic or 

logical operations automatically.  

A computer is an electronic device that manipulates information, or data. It has the ability 

to store, retrieve, and process data. You can use a computer to type documents, send email, and 

browse the Web. You can also use it to handle spreadsheets, accounting, database management, 

presentations, games, and more. 

In World War II, mechanical analog computers were used for specialized military applications. 

During this time the first electronic digital computers were developed. Computer was developed by 

CHARLES BABBAGE. He is also known as Father of computers. 

 

 

   

  

 

 

 

 

 

 

Organization of a Computer 

Computer can also be defined in terms of functions it can perform. A computer can 

• Accept data,  

• Store data,  

• Process data as desired,  

• Retrieve the stored data as and when required and  

• Print the result in desired format. 

 

Output Unit          Processing Unit      INPUT

  

     Memory 
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Characteristics of computer:-

 
Block diagram of Computer:- 

 
1. Input: this is the process of entering data and programs into the computer system. 
2. Control Unit (CU): The process of input, output, processing and storage is performed under 

the supervision of a unit called 'Control Unit'. It decides when to start receiving data, when to 
stop it, where to store data, etc. It takes care of step -by-step processing of all operations 
inside the computer. 

3. Memory Unit: Computer is used to store data and instructions. 
4. Arithmetic Logic Unit (ALU): The major operations performed by the ALU are addition, 

subtraction, multiplication, division, logic and comparison. 
5. Output: This is the process of producing results from the data for getting useful information. 

The ALU and the CU of a computer system are jointly known as the central processing unit 

(CPU). You may call CPU as the brain of any computer system. 

Speed

Accuracy

Power of Remembering

Diligence

Versatility

No IQ

No Feeling

Storage
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Motherboard 

A motherboard is the main printed circuit board (PCB) found in general 

purpose microcomputers and other expandable systems. It holds and allows communication between 

many of the crucial electronic components of a system, such as the central processing unit (CPU) 

and memory, and provides connectors for other peripherals. A motherboard usually contains 

significant sub-systems such as the central processor, the chipset's input/output and memory 

controllers, interface connectors, and other components integrated for general purpose use. 

Motherboard specifically refers to a PCB with expansion capability and as the name suggests, this 

board is often referred to as the "mother" of all components attached to it, which often 

include peripherals, interface cards, and sound cards, video cards, network cards, hard drives, or other 

custom components. 

Computer Hardware: 

In simple terms we can say, computer parts that have tangible property are comes under computer 

hardware categories. Computer hardware is the physical parts or components of a computer.  This is 

also sometime called the machinery or the equipment of the computer. 

 

Computer Software:  

Computer software is instructions that can be stored and run by hardware. Software is any set of 

machine-readable instructions that directs a computer's processor to perform specific operations.  

 

 

 

 

 

 

 

 

 

 

 

 

 

• Insurance 

• Banking 

• Business 

• Education 

• Marketing 

• Health Care 

• Engineering Design 

• Military 

• Communication 

• Government Applications 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The various applications of Computers:- 
 

Computer 
Software 

Hardware 

https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Microcomputer
https://en.wikipedia.org/wiki/Central_processing_unit
https://en.wikipedia.org/wiki/Computer_memory
https://en.wikipedia.org/wiki/Peripherals
https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Peripheral
https://en.wikipedia.org/wiki/Sound_card
https://en.wikipedia.org/wiki/Video_card
https://en.wikipedia.org/wiki/Network_card
https://en.wikipedia.org/wiki/Hard_drive
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Input devices 

 

 

 
 

Input devices 

An input device is an electromechanical device as it utilizes both electronic and mechanical power. 

It aims in receiving data from external world. The input devices are responsible for converting data 

into a form that is understood by the computer. An input device is a peripheral device that converts 

symbols that people understand into bits that computers can process 

  

Basic working of input devices:- 
 

• Accept the data. 

• Convert it into the machine understandable form. 

 

Different Types of input devices:-  

 

• Keyboard 

• Mouse 

• Joystick 

• Light pen 

• Track Ball 

• Scanner 

• Microphone 

• Digitizing Tablet 

• Magnetic Ink Card Reader (MICR) 

• Optical Character Reader (OCR) 

• Bar Code Reader 

• Optical Mark Reader 

Computer Hardware 
- 

Input devices 
Output devices 
 

Storage device Processor 
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Keyboard 

Keyboard is one of the most commonly used input devices to input the date into the computer. It is 

like the traditional typewriter, although there are some additional keys provided for performing some 

additional functions. Keyboards are of two sizes 84 keys or 101/102 keys, but now 104 keys or 108 

keys. 

 

• Keyboard is an input device used to enter data in to computer by pressing one key at one time. 

• It has its own processor and circuitry that carries information to the processor. 

• When you press a key, it presses a switch, completing the circuit and allowing a tiny amount 

of current to flow through. 

• It tells the processor the position of each key what each keystroke or combination of keystrokes 

represents. 

 
• Despite the development of alternative input devices, such as mouse, touch screen, light 

pen, the keyboard remains the most commonly used and most versatile device used for direct 

(human) input into computers. 

• One factor determining the size of a keyboard is the presence of duplicate keys, such as a 

separate numeric keyboard, for convenience. 

•  Another factor determining the size of a keyboard is the size and spacing of the keys. 

 

Generally the keyboards contain the following keys, they are:- 

 Alphabets 

 Arithmetic operators such as +, -, *, / 

 Numeric digits 0–9 

 Cursor arrow keys 

 Navigation keys such as Home, End, PgUp, PgDown, etc. 

 Num Lock button, used to enable or disable the numeric pad 

 Enter key 

 

Mouse: 

The mouse is used to point to a particular place on the screen and select to perform one or more action. 

The pointing device may point to the menu, commands, size windows, starts programs etc. The most 

conventional kind of mouse has two buttons on top: the left one being used most frequently then right 
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one. A mouse is a pointing device that functions by detecting 2D motion relative to its supporting 

surface. The mouse's motion typically translates into the motion of a pointer on a display, which allows 

for fine control of a graphical user interface 

 

Mouse Actions 

• Left Click  

• Double Click  

• Right Click  

• Drag and Drop 

Types of mouse:- 

 

• Mechanical mouse:  

• Optical mouse:  

• Cordless 3-D mouse:  

•  Wireless Mouse:  

o  RF Transmitter:  

o RF Receiver:   

 

                       
             

Track ball: 

This is also a pointing device. Track ball is an input device that is mostly used in notebook or laptop 

computer, instead of a mouse. This is a ball, which is half inserted and 

by moving fingers on ball, pointer can be moved. Since the whole 

device is not moved, a track ball requires less space than a mouse. A 

track ball comes in various shapes like a ball, a button and a square.  

 

Compared with a mouse, a trackball has no limits on effective travel; at 

times, a mouse can reach an edge of its working area while the operator 

still wishes to move the screen pointer farther. With a trackball, the 

operator just continues rolling, whereas a mouse would have to be lifted 

and re-positioned. 

Joystick:- 

The joystick is handheld stick. This stick can rotate about one end 

transmitting its angle to the computer in two or three dimensions. It 

typically has a button on top that is used to select the option pointed by the 

cursor. Joysticks are often used to control video games, and usually have 

one or more push-buttons whose state can also be read by the computer. 

 

 

Digitizing Tablet: 

An input device that permits drawing of images and graphics is called a 

digitizing tablet. They give feeling of drawing images with pencil and 

paper. The graphics tablet has two major parts that are:- 

• A flat surface on which the image is drawn.  

• Stylus that helps in drawing. 
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Scanners 

An input device capable to read text or illustrations printed on a paper and 

interpret it in a form that can be used by a computer is known as a scanner. 

It converts the document image into digital form so that it can be fed into 

the computer. Capturing information like this reduces the possibility of 

errors typically experienced during large data entry. 

 

Digital Camera 

A digital camera can store many more pictures than an ordinary camera. Pictures taken using a digital 

camera are stored inside its memory and can be transferred to a computer by connecting the camera to 

it. A digital camera takes pictures by converting the light passing through the lens at the front into a 

digital image. 

There are several categories in which the cameras can be classified:- 

• Video camera  

➢ Professional video cameras 

➢ Camcorders used by amateurs. 

➢ webcams  

• Digital camera 

➢ Live-preview digital cameras 

➢ Compact digital cameras 

➢ Bridge cameras 

 

 

Magnetic Ink Character Recognition: 

 

 
MICR is also an input device is commonly used in banks because of a large number of cheques to be 

processed. The bank's code number and cheque number are printed on the cheques with a special type 

of ink that contains particles of magnetic material that are machine readable. This reading process is 

called Magnetic Ink Character Recognition (MICR).  

 

Magnetic Ink Character Recognition is a character recognition system that uses special ink and 

characters. When a document that contains this ink needs to be read, it passes through a machine, 

which magnetizes the ink and then translates the magnetic information into characters. 

 

MICR technology is used by banks. Numbers and characters found on the bottom of checks (usually 

containing the check number, sort number, and account number) are printed using Magnetic Ink. To 

print Magnetic Ink need, you need a laser printer that accepts MICR toner. 
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MICR provides a secure, high-speed method of scanning and processing information. 

 

Optical character Reader:-  

Optical character Reader is an input device that is use to read a printed text. The OCR 

scans text optically character by character, converts them into a computer readable code 

and stores the text on the system memory.  

 

Optical Mark Reader:- 

Optical mark reader is also known as optical mark recognition that is same as the scanner which reads 

on specific areas of the page. Thus OMR can be defined as the process of scanning paper-based 

documents and identify data or marks in a location defined previously. 

It is specially used for checking the answer sheets of examinations having multiple choice questions. 

Bar Code Reader:- 

An electronic device used to read barcodes printed on various surfaces is called 

barcode reader. It is also known as barcode scanner. Bar Code Reader scans a bar 

code image, converts it into an alphanumeric value, which is then fed to the 

computer to which bar code reader is connected. 

Bar coded data is generally used in labeling goods, numbering the books, etc. It may 

be a hand-held scanner or may be embedded in a stationary scanner. 

 

Voice Recognition System:- 

Voice recognition systems are alternatively known as voice data entry or audio data entry terminals. 

This method of input enables a programmer to instruct the computer with spoken words instead of a 

written program 

Light Pen:- 

Light pen is also an input device used as pointing device, 

which is similar to a pen. It is used to select a displayed 

menu item or draw pictures on the monitor screen. It 

consists of a photocell and an optical system placed in a 

small tube. 

 A light pen is a computer input device used in 

conjunction with a computer's CRT display. 

 It allows the user to point to displayed objects or 

draw on the screen in a similar way to a touch screen but with greater positional accuracy. 

 A light pen detects a change of brightness of nearby screen pixels when scanned by cathode 

ray tube electron beam and communicates the timing of this event to the computer. 

 Because the user is required to hold his arm in front of the screen for long period of time, the 

light pen fell out of use as a general purpose input device. 

Touch screen:- 

An input device that permits users to operate a PC by simply touching the display screen is called a 

touch screen. The touch screen is as easy to use as trackballs or touchpad’s. 

Three major components form a basic touch screen they are as follows:- 

• Touch sensor 

• Controller 

• Software driver  
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Output Devices 

 

An output is an electromechanical device that receives output from a computer in binary coded form 

and converts it into human understandable form and transmits to the user. An output device is 

any peripheral that receives data from a computer, usually for display, projection, or physical 

reproduction. 

• Monitor / Visual Display Unit 

• Printer 

• Plotter 

• Speaker 

 

Monitor: 

 
 

Monitor is the most common and the most popular output device.  It forms images from tiny dots, 

called pixels that are arranged in a rectangular form. The sharpness of the image depends upon the 

number of the pixels. 

 

There are two types of viewing screen used for monitors: 

 

Cathode-Ray Tube (CRT):  

The CRT display is made up of small picture elements called pixels. The smaller 

the pixels, the better the image clarity, or resolution. It takes more than one 

illuminated pixel to form whole character, such as the letter ‘e’ in the word help. 

• There are some disadvantages of CRT: 

• Large in Size 

• High power consumption 

 

LCD(Liquid Crystal Display) 

Monitor

Monochrome Gray Scale Color

CRT LCD LED
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Printer:- 

A printer is an output device that is used in a computer to print alphanumeric characters on papers. It 

converts the electronic signals from the computer into human readable form or hardcopy to produce a 

print out of the result of data processed in the computers. 

 

 
 

Plotter:- 

A plotter is a vector graphics printing device that connects to a computer. It draws pictures on paper 

based on commands from computer. A plotter is a very versatile tool. 

 

Types of plotters:- 

• Drum plotter 

• Flat-Bed plotter 

 

Sound Cards:- 

Sound cards are a important part of computer, without sound cards you will have no music, no effects 

and no voices. Sound card is also referred as a sound board or an audio card, a sound card is 

an expansion card or integrated circuit that provides a computer with the ability to produce sounds that 

can be heard by the user either over speakers or headphones.  

Printers

Impact

Dot Matrix

Line

Daisy Wheel

Drum

Chain

Non Impact

Laser

Ink Jet

Photo

Portable
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Sound card connections are as follows:- 

• Digital out 

• Sound in or line in 

• Microphone or Mic 

• Sound out or line out 

• Fire wire 

• MIDI or Joystick 

 

Speakers:- 

A hardware device that is connected to a 

computer's sound card that outputs sounds 

generated by the computer is referred as 

speaker. Speakers are rated in Frequency 

response, Total Harmonic Distortion, and 

Watts.  

 

Storage:- 

Computer data storage is often known as storage or memory refers to computer components and 

recording media that retain digital data used for computing for some interval of time. A memory is just 

like a human brain. It is used to store data and instructions. Computer memory is the storage space in 

computer where data is to be processed and instructions required for processing are stored. 

Memory is primarily of two types: 

• Primary Memory/Main Memory 

• Secondary Memory 

 
 

Primary memory:- 

Primary memory holds only those data and instructions on which computer is currently working. It has 

limited capacity and data gets lost when power is switched off. It is generally made up of 

semiconductor device. These memories are not as fast as registers. The data and instructions required 

to be processed earlier reside in main memory. Primary memory is divided into two categories they 

are as follows:- 

• RAM 
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• ROM. 

 

RAM:- 

Full form of  RAM random access memory (RAM). A RAM constitutes 

the internal memory of the CPU for storing data, program and program 

result. It is read/write memory. Since access time in RAM is independent 

of the address to the word that is, each storage location inside the memory 

is as easy to reach as other location & takes the same amount of time. RAM 

is volatile, i.e., data stored in it is lost when we there is a power failure. 

Hence, a backup uninterruptible power system (UPS) is often used with 

computers. RAM is small, both in terms of its physical size and in the amount of data it can hold. 

There are two types of RAM they are as follows:- 

• Static RAM (SRAM)  

• Dynamic RAM (DRAM) 

 

ROM:- 

ROM is Read Only Memory. ROM are the memories on which it is 

not possible to write the data when they are online to the computer. 

They can only be read. It is a permanent in built in the computer at 

the time of its production. It is also known as firmware. It stores the 

set of instructions permanently which instructs the computer how to 

work. The ROM can be used in storing micro programs, system 

programs, subroutines. 

Types of ROM are as follows:- 

• PROM 

• EPROM 

• EEPROM 

 

Secondary memory:- 

Secondary memory is also known as external memory or non-volatile. It is slower than primary 

memory. These are used for storing Data/Information permanently the data one stored will not be 

erased as the power is switched off. CPU directly does not access these memories, instead they are 

accessed via input-output routines. Contents of secondary memories are first transferred to main 

memory and then CPU can access it.  

Types of secondary memory are as follows:- 

• Magnetic tapes 

• Magnetic disk 

 

Magnetic tapes:- 

Magnetic tape is the most commonly used device for storing large data. It is sequential access device. 

Magnetic tape is a strip or ribbon of plastic which is coated with Ferro magnetic oxides. It is generally 

80-2400 feet long and ½ inch wide, in size. 

 

Magnetic Disk:- 

A magnetic disk is a circular plate constructed of metal or plastic coated with magnetized material. 

Both sides of the disk are used and several disks may be stacked on one spindle with read/write heads 



 
BAMC II year     Subject: Information Commination Technology 

 

 

45, Anurag Nagar, Behind Press Complex, Indore (M.P.) Ph.: 4262100, www.rccmindore.com 
14 

 

available on each surface. Bits are stored in magnetized surface in spots along concentric circles called 

tracks. Tracks are commonly divided into sections called sectors. Disk that are permanently attached 

and cannot removed by occasional user are called hard disks. A disk drive with removable disks is 

called a floppy disk drive. 

 

Types of magnetic disk:- 

• Hard disk 

• Floppy disk 

• Compact disk 

• Video CD 

• DVD 

Floppy Disk 

 
 

The floppy disk gets its name from the fact that 

it is made out of a flexible plastic material. The 

plastic base is coated with an iron-oxide 

recording substance that's similar to the 

material applied to the plastic ribbon of a 

magnetic tape. Data are recorded as tiny 

invisible magnetic spots on this coating
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.  

CD-ROM 

The CD-ROM (Compact Disk Read Only Memory) is a direct extension of audio CD. CD-ROM 

players are more rugged and have error correction facility. This ensures proper data transfer from CD-

ROM to the RAM of the computer. CD-ROM is written using a CD writer. Information is retrieved 

from a CD-ROM using a low power laser, which ingenerate in an on optical disk drive unit.  

Hard Disk 

The disk described so far is the type of disks which can be removed from the disk drive and carried 

from place to place. Some disks however, are built into the computer or a special disk drive.. Hard 

disks can store anywhere from 20 MB to more than 40GB. Hard disks are also from 10 to 100 times 

faster than floppy disk. 

 

USB drive (1) An external hard disk drive or optical disc drive that plugs into the USB port. portable 

hard drive. (2) A solid state storage module that plugs into the computer's USB port. Using flash 

memory chips that hold up to one terabyte of data, the solid state USB drive emulates a hard disk. 

A USB flash drive -- also known as a USB stick, USB thumb drive or pen drive -- is a plug-and-play 

portable storage device that uses flash memory and is lightweight enough to attach to a keychain. A 

USB flash drive can be used in place of a compact disc. 

 

Cache Memory 

Cache memory is faster than the main memory. The cache memories although are fast yet are very 

expensive memories and are used in only small size. Thus, small cache memories are intended to 

provide fast speed of memory retrieval without sacrificing the size of memory. Cache memory stores 

a copy of the instructions and data to be immediately used of main memory. The memory reads or 

writes operation is first checked with cache memory and if the desired location data is available in 

cache memory then used by the CPU directly. 

 

Other Memories:- 

• Flash memory 

• Virtual memory 

• Cache Memory 

 

Software 

Software is a set of program which performs desired task. Software runs on hardware. Software is a 

sequence of instructions written to solve a particular problem. 

There are two types of software’s: 

• System Software 

• Application Software 

 

System Software:- 

System Software performs the basic functions necessary to start and operate a computer. It refers to 

all programs that make computer work. It controls and monitors the various resources of a computer 

such as processor, input-output devices and communication links. Example : - Operating System and 

Compiler  

 

System software is divided into three categories:- 
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• System management software 

• System support software 

• System development software 

 

Application Software:- 

Application software refers to the programs which help the computer to work effectively for specific 

applications. Example Ms- Office , Tally , Adobe etc. 

Application software is of two types:- 

• General purpose program 

• Application specific program 

Other software’s are as follows:- 

 

 Utility software 

 utility software are those software that is used for system utilization . 

like antivirus , window media player etc. 

Virus :-  

A computer virus is a program or piece of code that is loaded onto your computer without you 

knowledge and runs against your wishes. All computer virus are man made. 

A few prominent virus are Michelangelo, dishwasher, C-brain , macmag , nenusalem , columbus  etc. 

 

Antivirus : - a utility software that searches a hard disk for viruses and removes any that are found. 

Most antivirus programs include an auto update feature that enables the program to download profiles 

of nes virus so that it can check for the new viruses as soon as they are discovered. 

Some popular antivirus are NPAV, Quick heal ,Avast and Mac fee etc. 

Data compression is encoding of information using fewer bits than the original representation. The 

process of reducing the size of a data file is referred to as data compression  

• Lossy 

• Lossless 

Compression is useful because it reduces resources required to store and transmit data. Data 

compression is subject to a space–time complexity trade-off. For instance, a compression scheme for 

video may require expensive hardware for the video to be decompressed fast enough to be viewed as 

it is being decompressed, and the option to decompress the video in full before watching it may be 

inconvenient or require additional storage 

Disk Defragmenter is a utility in Microsoft Windows designed to increase access speed by 

rearranging files stored on a disk to occupy contiguous storage locations, a technique called 

defragmentation. 

Disk Cleaning is a computer maintenance utility included in Microsoft Windows designed to free up 

disk space on a computer's hard drive. The utility first searches and analyzes the hard drive for files 

that are no longer of any use, and then removes the unnecessary files. There are a number of different 

file categories that Disk Cleanup targets when performing the initial disk analysis: 

• Compression of old files 

• Temporary Internet files 

• Temporary Windows files 
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• Downloaded program files 

• Recycle Bin 

• Removal of unused applications or optional Windows components 

• Offline web pages (cached) 

Operating System 

An operating system is a program that acts as an interface between the user and the computer 

hardware and controls the execution of all kinds of programs. 

In technical terms, it is software which manages hardware. An operating System controls the 

allocation of resources and services such as memory, processors, devices and information. 

 

 

 
Following are some of important functions of an operating System. 

User

Application 
Software

System 
Software

Hardware
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•  
 

 

 
 

 MS Windows 

Windows XP is a personal computer operating system produced by Microsoft as part of 

the Windows NT family of operating systems. The operating system was released to manufacturing 

on August 24, 2001, and generally released for retail sale on October 25, 2001. 

Windows XP is a graphical user interface (GUI). It has pictures (graphical) that you use (user) to 

communicate (interface) with the computer. This type of system is popular because it's logical, fun, 

and easy to use. 

Functions 
of 

operating 
system

Memory 
Management

Process 
Management

Device 
Management

File 
Management

Control 
performance

Job 
accounting

Security

Coordination 
between 

other 
software and 

users

TYPES OF OPERATING 
SYSTEM

Real-
time

Single-
user

Multi-
user

Batch 
Proces
sing

Time-
sharin
g

Multi-
progra
mming

Multi 
Tasking
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This operating system has multi-tasking capabilities, meaning it can run several applications at the 

same time. Multi-tasking allows you to view this lesson on the Internet at the same time you practice 

using other applications with Windows XP. 

History of Windows: 

 

Versions Year 

Windows 10 Nov.1983 

Windows 1.0 Nov.1985 

Windows 2.0 09 Dec.1987 

Windows 3.0 22 May.1990 

Windows 95 August 1995 

Windows 98 June 1998 

Windows 2000 Feb.2000 

Windows XP 25 Oct. 2001 

Windows  Vista 2007 

Windows 7 22 July 2009 

Windows 8 26 Oct. 2012 

Windows 10 2015 

 

The New and updated features in the new program are: 

• Windows XP is faster, smarter, safer 

• Windows XP is easier to learn and use 

• Windows XP offers better help for every task 

• Playing music, video and CDs 

• Offers wizard 

• User interface 

• Infrastructure 

• Networking and internet functionality 

 

Windows XP editions 

• Home and Professional 

• Starter Edition 

• Media Center Edition 

• Tablet PC Edition 

• Subscription and pre-paid editions 

• 64-bit editions 

• Editions for embedded systems 

Windows XP is an operating system 

 Windows XP is a collection of programs, which enables the entire pc to work. Among Windows’ most 

important tasks are: 

• Assist in starting the pc. 
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• Control and handling of all hardware, including RAM, I/O, cards and controllers. 

• Read-in of a graphics user interface with windows, menu bars etc. 

• Forms a platform for the user programs (applications) like Word, Internet Explorer, and 

Photoshop etc. 

• Handling of user data in files. 

 

Beyond the pure operating system tasks Windows XP includes a large collection of smaller and larger 

tools. Among others Windows XP comes with Internet Explorer and the multimedia player Windows 

Media Player, which are independent user programs. 

 
 

Windows XP is both an operating system and a program package. 

 

Desktop 

Desktops in a WINDOWS is utility that allows users to manage applications on up to four virtual 

desktops, all accessible using the tray icon interface. 4. When referring to an operating system or GUI, 

the Desktop is a system of organization of icons on a screen. The Microsoft Windows Desktop was 

first introduced with Microsoft Windows 95 and has been included with every version of Windows 

since then. 

 
The desktop contains: 
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• Start button: This is one of the most important tools you will use while working with Windows 

XP. The Start button allows you to open menus and start applications. 

• Taskbar: This is primarily used to switch between open windows and applications. Learn more 

about using the taskbar in a later lesson. 

• Icons (or graphical pictures): This represents applications, files, and other parts of the 

operating system. By default, Windows XP provides you with one desktop icon, the Recycle 

Bin.  

• Windows Notification Area 

• Time and Date: The date and time is also shown on the Desktop, in the notification area on 

the taskbar. If the date and time is incorrect, you can change the date and time right from the 

Desktop. 

 

Exploring Windows Explorer 

Windows Explorer is a file management tool that lets you create, rename, and delete folders. It also 

allows you to copy, print, move, delete, rename, and manage files. 

To open Windows Explorer: 

1. Open My Documents. 

2. Click the Folders button on the Navigation toolbar. 

3. A list of folders opens in the left pane. 

To explore Windows Explorer: 

1. With Windows Explorer open, scroll until you see the Control Panel icon in the left pane. 

2. Click the Control Panel icon. The contents (of the Control Panel folder) display in the right 

pane. 

3. Practice viewing other folders in the list. 

4. To close Windows Explorer, click the small black X in the upper right of the list OR click 

the Folder button. 

 

The Taskbar 

The taskbar is the small blue bar you see at the bottom of your desktop. It contains the Start 

menu and the Quick Launch bar, which contains icons for Internet Explorer, Windows Media 

Player, and Show Desktop. Click an icon to open a program. Click Show Desktop to quickly view your 

desktop without closing any programs or windows. 

 
 

The box on the right is called the Notification Area. Microsoft also uses the Notification Area to 

remind you when software updates are available for download. 

 
 

When you open or minimize a window or program, a rectangular button appears on the taskbar that 

shows the name of the application.  

 

The Start menu 

When you click the Start button, the Start menu appears. The Start menu is your path to the 

applications on your computer. It contains two columns. The left side of the Start menu lists 
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programs, while the right side allows access to common Windows folders (My Documents, for 

example). It also provides access to Help and Support, Search, and Run. If you select All Programs, 

a pop-up menu appears. Pop-up menus like this are called cascading menus. If a cascading menu is 

available, a small black triangle appears next to the name of the application or function. 

To explore the Start menu: 

1. Click the Start button. 

2. Move the mouse pointer to each option, and view the various cascading menus. 

3. Click (or roll your mouse pointer over) All Programs. 

4. Move the mouse pointer to the right, and view other cascading menus. 

5. To exit the menus, click outside the menu area or press Esc on your keyboard. 

 
 

The Recycle Bin 

The Recycle Bin is nothing more than a space on the hard disk reserved to store information that is 

deleted so that in the event of deleting a file or folder by mistake it is possible to retrieve it. By default 

the Recycle Bin restores files or folders to the place from where they were deleted. If, for example, a 

file is deleted from D:\my documents, when it is restored it will go to that folder. 

The Recycle Bin will maintain the deleted documents until it is emptied. 

To open the Recycle Bin place the cursor on Desktop and double-click on the Recycle Bin icon.  

 

Restoring Files or Folders 

To restore all of the elements from the Recycle Bin click on the green arrow on the left side that 

says restore all items. 

 

If we only want to restore some of the elements: 
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1) Select the elements to be restored by clicking on them. If the elements are not in subsequent order, 

use the Ctrl key to select them or the Shift key if they are one below the other. 

2) Once selected, a dialog box will appear on the green arrow on the left that will say Restore this 

item or Restore the selected items. 

The selected files will return to where they were located before deletion. 

 

Deleting Files or Folders from the Recycle Bin 

Before deleting any element from the Recycle Bin you need to realize that once it is deleted it cannot 

be retrieved or restored. 

 If you want to delete any file or folder from the Recycle Bin follow these steps: 

1) Select the Elements to be deleted. 

2) Click on ; this will delete the selected elements. You can also do this by pressing 

the Delete button. 

The selected files will disappear and cannot be restored. 

 

My Computer 

It is another tool you can use to manage files and folders. With this tool, you can create, rename 

and move folders and copy, print, move, delete and rename files. It also allows you to gain access 

to other 

system tools. 

To open My Computer: 

1. Double-click the My Computer icon on the desktop. 

2. My Computer opens. 

 

My Network Places overview 

My Network Places displays shortcuts to shared computers, printers, and other resources on the 

network. The shortcuts are created automatically in My Network Places whenever you open a shared 

network resource, such as a printer or shared folder. 

 

Open My Network Places 

• To open My Network Places, click Start, and then click My Computer. Under Other Places, 

click My Network Places.  

• The View workgroup computers task is displayed in My Network Places when your computer 

is in a workgroup and not in a domain. Double-click this icon to narrow your search to only 

those computers, printers, and resources that share a workgroup with your computer.  

• If your computer is connected to a workgroup that has less than 32 computers, Windows will 

automatically create shortcuts in My Network Places to the shared resources in your 

workgroup.  

• To add a shortcut in My Network Places to a folder on a Web server, the Web server must 

support network places.. 

 

My Documents 

The My Documents folder is your own personal folder in which you can store your documents, 

graphics, and other personal files. You can change the target if you want My Documents to point to a 

different folder location.  

• Change the Default Location of the My Documents Folder 
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• To change the default location of the My Documents folder, follow these steps:  

• Click Start, and then point to My Documents.  

• Right-click My Documents and then click Properties. Click the Target tab.  

 

User Accounts 

To get at the settings for the User Accounts, click Start and then Control Panel. From the Control 

Panel, double click User Accounts.  

• We can create a new user account. 

• We can make the account as password protected. 

• Through admin we can even change the password. 

 

Windows XP Accessories Applications:  

• Calculator,  

• Notepad,  

• WordPad,  

• Paint  

 

Using Windows XP Notepad  

Notepad is a miniature text after the 

calculations are performed. To enter 

numbers from the editor.  Just as you use 

a notepad on your desk, you can use 

Notepad to take notes onscreen while 

working in other Windows applications. 

 

Because Notepad stores files in text 

format, almost all word processing 

applications can retrieve Notepad's files. 

However, if you want the capability of formatting your documents, you'll need a true word processor. 

 

Starting Notepad 

To start Notepad, open the Start menu and choose Programs, Accessories, Notepad. Notepad starts up 

and displays a blank document in the Notepad window . 

 

Working with Documents in Notepad 

You can move the insertion point by using either the mouse or the keyboard. You select and edit text 

in Notepad the same way you select and edit text in WordPad. 

Limited formatting is available from the File, Page Setup command. You can change margins and add 

a header or footer, but you cannot format characters or paragraphs in any way. You also can use the 

Tab, Spacebar, and Backspace keys to align text. Tab stops are preset at every eight characters. 

 

With the commands on Notepad's Edit menu, you can cut, copy, and move text from one place in a 

file to another. Text that you cut or copy is stored in the Clipboard. When you paste text, the contents 

of the Clipboard are copied from the Clipboard to the document at the location of the insertion point. 
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 4.Using Windows XP Paint 

Paint is n easy-to-learn graphics application 

that you can use to create and modify graphics 

images. 

 

Steps for starting Windows Paint 

To start Paint, click Start, Programs, 

Accessories, Paint. Paint starts up and opens a 

new, empty Paint file 

 

5.Using Windows XP Entertainment 

 Windows XP includes entertainment programs 

for playing CDs, viewing multimedia files, and 

recording and playing back sounds.  

It is capable of performing many tasks like: 

1. Playing Games 

2. Changing the Volume 

3. Playing a Sound with Sound Recorder 

4. Playing an Audio CD 

5. Working with Media Player Controls 

6. Changing the Visualizations 

7. Copying CD Tracks 

8. Using the Media Library 

9. Creating a Playlist 

10. Tuning into the Radio 

11. Changing the Skin for Windows Media Player 

12. Playing a Video Clip 

13. Importing a Movie with Windows Movie Maker 

 

Changing Mouse Pointer 

1. Open Mouse Properties by clicking the Start button The Start button, and then clicking 

Control Panel. In the search box, type mouse, and then click Mouse. 

2. Click the Pointers tab, and then do one of the following:        

• To give all of your pointers a new look, click the Scheme drop-down list, and then click a 

new mouse pointer scheme. 

• To change an individual pointer, under Customize, click the pointer you want to change 

in the list, click Browse, click the pointer you want to use, and then click Open. 

3. Click OK. 

To change your desktop background 

1. Open Display in Control Panel. 

To open Display, click Start, click Control Panel, click Appearance and Themes, and then 

click Display.  

2. On the Desktop tab, do one or more of the following: 

• Click a picture in the Background list. In Position, click Center, Tile, or Stretch. 
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• Click Browse to search for a background picture in other folders or on other drives. You can 

use files with the following extensions: .bmp, .gif, .jpg, .dib, .png, .htm. In Position, 

click Center, Tile, or Stretch. 

• Select a color from Desktop color. The color fills the space not used by a picture. 
 

Note 

•      To open Display, click Start, click Control Panel, click Appearance and Themes, and then 

click Display.  

•      You can use a personal picture as a background. All of your personal pictures located in My 

Pictures are listed by name in the Background list. 

•      You can save a picture from a Web site as a background. Right-click the picture and then click Set 

as Background. The picture is listed in the Background box as Internet Explorer Background. 

•      If you choose an .htm document as your background picture, the Position options are unavailable. 

The .htm document is automatically stretched to fill your background. 

Copying and Moving Files and Folders 
Sometimes you will need to move a file from one folder to another, or copy a file from one folder to 

another, leaving the file in the first location and placing a copy of it in the second. You can move or 

copy a file or folder using a variety of methods. If the file or folder and the location where you want 

to move it are visible in a window or on the desktop, you can simply drag the item from one location 

to the other. Moving a file or folder on the same disk relocates it whereas dragging it from one disk 

to another copies it so that it appears in both locations. When the destination folder or drive is not 

visible, you can use the Cut (to move), Copy, and Paste commands on the Edit menu to move or 

copy the items. 

Copy a File or Folder 

1.  Open the drive or folder containing the file or folder you want to copy. 

2.  Select the files or folders you want to copy. 

Move a File or Folder 

1.  Open the drive or folder containing the file or folder you want to move. 

2.  Select the files or folders you want to move. 

3. Click the Organize button on the toolbar, and then click Cut. 

4.  Display the destination folder where you want to move the files or folder. 

5.  Click the Organize button on the toolbar, and then click Paste. 

Copy or Move a File or Folder Using Drag and Drop 

1.  Open the drive or folder containing the file or folder you want to copy or move. 

2.  Select the files or folders you want to copy or move. 

3. In the Navigation pane, point to a folder list to display the expand and collapse arrows. 

4.  Click the arrows to display the destination folder, and then click the destination folder. 

5.  Right-click the selected files or folders, drag to the destination folder, and then click Copy 

Here or Move Here. 

  



 
BAMC II year     Subject: Information Commination Technology 

 

 

45, Anurag Nagar, Behind Press Complex, Indore (M.P.) Ph.: 4262100, www.rccmindore.com 
27 

 

UNIT-2 

Microsoft Word 

Word processor 

A word processor is an electronic device or computer application software that performs word 

processing: the composition, editing, formatting and sometimes printing of any sort of written material. 

Word processing can also refer to advanced shorthand techniques, sometimes used in specialized 

contexts with a specially modified typewriter. 

The word processor emerged as a stand-alone office machine in the 1970s and 1980s, combining the 

keyboard text-entry and printing functions of an electric typewriter with a dedicated computer 

processor for the editing of text. 

 

Characteristics 

Word processing typically implies the presence of text manipulation functions that extend beyond a 

basic ability to enter and change text, such as automatic generation of: 

➢ batch mailings using form letter template and an address database (also called mail merging); 

➢ indices of keywords and their page numbers; 

➢ tables of contents with section titles and their page numbers; 

➢ tables of figures with caption titles and their page numbers; 

➢ cross-referencing with section or page numbers; 

➢ footnote numbering; 

➢ New versions of a document using variables (e.g. model numbers, product names, etc.) 

 

Examples of different word processing software are: 

➢ WordPerfect 

➢ Microsoft Word 

➢ WordMark 

➢ Lotus WordPro 

➢ Procedure Write 

Types of word processor:- 

➢ Dedicated word processor 

➢ Standard word processor software packages 

➢ Word processing packages on minicomputer 

 

Microsoft office Word:- 

Microsoft Office Button :- After clicking you get the Menu to create, open, save and perform 

other operations 

The Ribbon:- The Ribbon is the panel at the top portion of the document. It has seven tabs: Home, 

Insert, Page Layout, References, Mailings, Review, and View that contain many new and existing 

features of Word.  

Each of the tabs contains the following tools: 

• Home: Clipboard, Fonts, Paragraph, Styles, and Editing.  

•  Insert: Pages, Tables, Illustrations, Links, Header & Footer, Text, and Symbols 

•  Page Layout: Themes, Page Setup, Page Background, Paragraph, Arrange 

•  References: Table of Contents, Footnote, Citation & Bibliography, Captions, Index, and 

Table of Authorities 

•  Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results, Finish 
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• Review: Proofing, Comments, Tracking, Changes, Compare, Protect 

•  View: Document Views, Show/Hide, Zoom, Window, Macros 

 

Ruler: - Can use to change the format of your document quickly. 

Text area: - The area for writing the document is called Text Area. 

Status Bar: - appears at the very bottom of your window and provides the information about the 

current page and number of words in your document. 

Scroll Bar: - you have two types of scroll bar i.e. horizontal and vertical scroll bar to move the 

document. 

 

 
 

Formatting Features of Ms Word:- 

 
 

The commonly used are as follows:- 

• Bold and italic 

• Underlined 

• Font style 

• Font size 
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• Text color 

• Indent 

• Alignment 

 

To format font size: 

• Select the text you wish to modify. 

• Left-click the drop-down arrow next to the font size box on the Home tab. The font size 

drop-down menu appears. 

• Move your cursor over the various font sizes. A live preview of the font size will appear in 

the document. 

• Left-click the font size you wish to use. The font size will change in the document. 

 

To format font style: 

• Select the text you wish to modify. 

• Left-click the drop-down arrow next to the font style box on the Home tab. The font style 

drop-down menu appears. 

• Move your cursor over the various font styles. A live preview of the font will appear in the 

document. 

• Left-click the font style you wish to use. The font style will change in the document. 

 

To format font color: 

• Select the text you wish to modify. 

• Left-click the drop-down arrow next to the font color box on the Home tab. The font color 

menu appears. 

• Move your cursor over the various font colors. A live preview of the color will appear in the 

document. 

• Left-click the font color you wish to use. The font color will change in the document. 

 

To use the bold, italic, and underline commands: 

• Select the text you wish to modify. 

• Click the bold, italic, or underline command in the Font group on the Home tab. 

 

To change the text case: 

• Select the text you wish to modify. 

• Click the Change Case command in the Font group on the Home tab. 

• Select one of the case options from the list. 

 

To change text alignment: 

• Select the text you wish to modify. 

• Select one of the four alignment options from the Paragraph group on the Home tab. 

o Align Text Left: Aligns all of the selected text to the left margin. 

o Center: Aligns text an equal distance from the left and right margins. 

o Align Text Right: Aligns all of the selected text to the right margin. 

o Justify: Justified text is equal on both sides and lines up equally to the right and left 

margins. Traditionally, many books, newsletters, and newspapers use full 

justification. 

 

Working with text:- 
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To insert text: 

• Move your mouse to the location you wish text to appear in the document. 

• Left-click the mouse. The insertion point appears. 

• Type the text you wish to appear. 

 

To delete text: 

• Place your cursor next to the text you wish to delete. 

• Press the Backspace key on your keyboard to delete text to the left of the cursor. 

• Press the Delete key on your keyboard to delete text to the right of the cursor. 

 

To select text: 

• Place the insertion point next to the text you wish to select. 

• Left-click your mouse and while holding it down, drag your mouse over the text to select it. 

• Release the mouse button. You have selected the text. A highlighted box will appear over the 

selected text. 

When you select text or images in Word, a hover toolbar with formatting options appears. This 

makes formatting commands easily accessible, which can save you time. 

 

To copy and paste text: 

• Select the text you wish to copy. 

• Click the Copy command on the Home tab. 

• Place your insertion point where you wish the text to appear. 

• Click the Paste command on the Home tab. The text will appear. 

 
To drag and drop text: 

• Select the text you wish to copy. 

• Left-click your mouse, and drag the text to the location you wish it to appear. The cursor will 

have a text box underneath it to indicate that you are moving text. 

 
 

 

Word Art 

Word Art are styles that can be applied to text to create a visual effect. To apply Word Art:- 

• Select text 

• Click insert tab 

• Click word Art 

• Choose the Word Art 
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• Select the Word Art 

• Click the format tab from the drawing 

tools 

• Click Word Art button  

 

Working with Header, Footers and Footnotes 

The header is a section of the document that appears in the top margin, while the footer is a section of 

the document that appears in the bottom margin. Headers and footers generally contain information 

such as page number, date, and document name.  

Header: - Header consists of text and graphics appears at the top of every page of a document. 

Footers: - Footers appears at the bottom of every page in the same document. 

For e.g.: - you can date page number, the time and date, a company logo, the document title. 

 

Steps to insert header and footers:- 

 There are different options to inset header and footer they are as follows:- 

• Insert the same header or footer on each page 

✓ Insert predefined header and footer 

✓ Insert custom header and footer 

• Make the first page header or footer different from the rest of the pages. 

• Make the header or footer different for odd and even pages. 

• Make the header or footer different in each section or chapter 

• Use documents section breaks to vary the header or footer. 

• Use the same header or footer across section boundaries 

• Change the contents of a header or footer 

• Insert a page number 

 

To insert a header or footer: 

• Select the Insert tab. 

• Click either the Header or Footer command. A menu appears with a list of built-in 

options you can use. 

• Left-click one of the built-in options, and it will appear in the document. 

 

OR 

• Left-click Blank to select it. 
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• The Design tab with Header and Footer tools is active. 

 
 

• Type information into the header or footer. 

 
 

To insert the date or time into a header or footer: 

• With the header or footer section active, click the Date & Time command. 
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• Select a date format in the dialog box that appears. 

• Click OK. The date and time now appear in the document. 

 

Other header and footer options 

There are many other header and footer options you can use to design these sections of your 

document. From the Header and Footer Tools Design tab, you can see all of your design options.  

 

Footnotes and end notes:- 

• A footnote or an endnote consists of two linked parts — the note reference mark (note reference 

mark: A number, character, or combination of characters that indicates that additional 

information is contained in a footnote or endnote.) and the corresponding note text. 

• When you add, delete, or move notes that are automatically numbered, Word renumbers the 

footnote and endnote reference marks. 

 

To insert a foot note:- 

• In Print Layout view, click where you want to insert the note reference mark.  

• On the References tab, in the Footnotes group, click Insert Footnote or Insert Endnote.  

• To make changes to the format of footnotes or endnotes, click the Footnotes Dialog Box 

Launcher, and do one of the following:  

• In the Number format box, click the format that you want.  

• To use a custom mark instead of a traditional number format, click Symbol next to Custom 

mark, and then choose a mark from the available symbols.  

• Click Insert.  

• Type the note text.  

• Double-click the footnote or endnote number to return to the reference mark in the document.  

 

Adding SmartArt: 

• Click insert tab 

• Click SmartArt button 

• Choose the Smartart 

• Click the SmartArt. 

• Drag it to the desired location in 

document 
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Mail Merge 

Mail Merge is used to create and print letters and other documents, such as a form letter that is 

sent to many customers. Each letter has the same kind of information, yet the content is unique. 

For example, in letters to your customers, each letter can be personalized to address each 

customer by name. The unique information in each letter comes from entries in a data source.  

The mail merge process entails the following overall steps: 

• Set up the main document: - The main document contains the text and graphics that are 

the same for each version of the merged document — for example, the return address or 

salutation in a form letter.  

• Connect the document to a data source:-A data source is a file that contains the 

information to be merged into a document. For example, the names and addresses of the 

recipients of a letter.  

• Refine the list of recipients or items. Microsoft Office Word generates a copy of the main 

document for each item, or record, in your data file. If your data file is a mailing list, 

these items are probably recipients of your mailing. If you want to generate copies for 

only certain items in your data file, you can choose which items (records) to include.  

• Add placeholders, called mail merge fields, to the document. When you perform the mail 

merge, the mail merge fields are filled with information from your data file.  

• Preview and complete the merge. You can preview each copy of the document before 

you print the whole set.  

• You use commands on the Mailings tab to perform a mail merge. 

 You can also perform a mail merge by using the Mail Merge task pane, which leads you step by 

step through the process. To use the task pane, in the Start Mail Merge group on the Mailings 

tab, click Start Mail Merge, and then click Step by Step Mail Merge Wizard. 

Steps 1-3 

• Choose the type of document you wish to create. In this example, select Letters. 

• Click Next: Starting document to move to Step 2. 

• Select Use the current document. 

• Click Next: Select recipients to move to Step 3. 

• Select the Type a new list button. 

• Click Create to create a data source. The New Address List dialog box appears. 

o Click Customize in the dialog box. The Customize Address List dialog box 

appears. 

o Select any field you do not need and click Delete. 

o Click yes to confirm that you wish to delete the field. 

o Continue to delete any unnecessary fields. 

o Click Add. The Add Field dialog box appears. 

o Enter the new field name. 

o Click OK. 

o Continue to add any fields necessary. 

o Click OK to close the Customize Address List dialog box. 

To Customize the New Address List: 

• Enter the necessary data in the New Address List dialog box. 

• Click New Entry to enter another record. 

• Click Close when you have entered all your data records. 

• Enter the file name you wish to save the data list as. 
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• Choose the location you wish to save the file. 

• Click Save. The Mail Merge Recipients dialog box appears and displays all the data records 

in the list. 

• Confirm the data list is correct and click OK. 

• Click Next: Write your letter to move to Step 4. 

 

Steps 4-6 

• Write a letter in the current Word document, or use an open, existing document. 

To Insert Recipient Data from the List: 

o Place the insertion point in the document where you wish the information to appear. 

o Select Address block, Greeting line, or Electronic postage from the task pane. A dialog 

box with options will appear based on your selection. 

OR 

o Select More Items. The Insert Merge Field dialog box will appear. 

o Select the field you would like to insert in the document. 

o Click Insert. Notice that a placeholder appears where information from the data record 

will eventually appear. 

o Repeat these steps each time you need to enter information from your data record. 

• Click Next: Preview your letters in the task pane once you have completed your letter. 

• Preview the letters to make sure the information from the data record appears correctly in 

the letter. 

• Click Next: Complete the merge. 

• Click Print to print the letters. 

• Click All. 

• Click OK in the Merge to Printer dialog box. 

• Click OK to send the letters to the printer. 

 

The Mail Merge wizard allows you to complete the mail merge process in a variety of ways.  
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Unit-3 

Introduction to MS Excel 

Microsoft Excel is an electronic spreadsheet that is used to record and analyse numerical data. You 

can use it to organize your data into rows and columns. Alphabetical letters are usually assigned to 

columns and numbers are usually assigned to rows. The point where a column and a row meet is 

called a cell. The address of a cell is given by the letter representing the column and the number 

representing a row. You can also use it to perform mathematical calculations quickly. It can be 

used in many business tasks, including statistics, finance, data management, forecasting, analysis, 

inventory, billing, and business intelligence. 

Three most important components of Excel are which you need to understand first: 

• Cell: A cell is a smallest but most powerful part of a spreadsheet. You can enter your data 

into a cell either by typing or by copy-paste. Data can be a text, a number, or a date. You 

can also customize it by changing its size, font color, background color, borders, etc. Every 

cell is identified by its cell address, cell address contains its column number and row 

number (If a cell is on 11th row and on column AB, then its address will be AB11). 

• Worksheet: A worksheet is made up of individual cells which can contain a value, a 

formula, or text. It also has an invisible draw layer, which holds charts, images, and 

diagrams. Each worksheet in a workbook is accessible by clicking the tab at the bottom of 

the workbook window. In addition, a workbook can store chart sheets; a chart sheet 

displays a single chart and is accessible by clicking a tab. 

• Workbook: A workbook is a separate file just like every other application has. Each 

workbook contains one or more worksheets. You can also say that a workbook is a 

collection of multiple worksheets or can be a single worksheet. You can add or delete 

worksheets, hide them within the workbook without deleting them, and change the order of 

your worksheets within the workbook. 
 

Microsoft Excel Interface & tools  

Before you start using it, it’s really important to understand that what’s where in its window. So 

ahead we have all the major component which you need to know before entering the world of 

Microsoft Excel. 
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1. Active Cell: A cell which is currently selected. It will be highlighted by a rectangular box 

and its address will be shown in the address bar. You can activate a cell by clicking on it or 

by using your arrow buttons. To edit a cell, you double-click on it or use F2 to as well.  

2. Columns: A column is a vertical set of cells. A single worksheet contains 16384 total 

columns. Every column has its own alphabet for identity, from A to XFD. You can select a 

column clicking on its header.  

3. Rows: A row is a horizontal set of cells. A single worksheet contains 1048576 total rows. 

Every row has its own number for identity, starting from 1 to 1048576. You can select a row 

clicking on the row number marked on the left side of the window.  

4. Fill Handle: It’s a small dot present on the lower right corner of the active cell. It helps you 

to fill numeric values, text series, insert ranges, insert serial numbers, etc. 

5. Address Bar: It shows the address of the active cell. If you have selected more than one cell, 

then it will show the address of the first cell in the range.  

6. Formula Bar: The formula bar is an input bar, below the ribbon. It shows the content of 

the active cell and you can also use it to enter a formula in a cell.  

7. Title Bar: The title bar will show the name of your workbook, followed by the application 

name (“Microsoft Excel”).  

8. File Menu: The file menu is a simple menu like all other applications. It contains options like 

(Save, Save As, Open, New, Print, Excel Options, Share, etc).  

9. Quick Access Toolbar: A toolbar to quickly access the options which you frequently use. 

You can add your favorite options by adding new options to quick access toolbar. 

10. Ribbon Tab: Starting from the Microsoft Excel 2007, all the options menus are 

replaced with the ribbons. Ribbon tabs are the bunch of specific option group which further 

contains the option.  

11. Worksheet Tab: This tab shows all the worksheets which are present in the workbook. 

By default you will see, three worksheets in your new workbook with the name of Sheet1, Sheet2, 

Sheet3 respectively.  

12. Status Bar: It is a thin bar at the bottom of the Excel window. It will give you an instant 

help once you start working in Excel. 

 

Microsoft Excel Basic Functions 

There are two basic ways to perform calculations in Excel: Formulas and Functions. 

1. Formulas 

In Excel, a formula is an expression that operates on values in a range of cells or a cell. For 

example, =A1+A2+A3, which finds the sum of the range of values from cell A1 to cell A3. 
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2. Functions 

Functions are predefined formulas in Excel. They eliminate laborious manual entry of formulas 

while giving them human-friendly names. For example: =SUM(A1:A3). The function sums all the 

values from A1 to A3. Functions are one of the most important features of Excel. It helps you to 

perform the basic calculations as well complex.  

1. SUM: It returns the sum of numeric values in a cell. You can refer to the cells where you 

have values or simply insert the values into the function [...] 

Syntax =SUM(number1, [number2], …) 

Example: 

=SUM(B2:G2) – A simple selection that sums the values of a row. 

=SUM(A2:A8) – A simple selection that sums the values of a column. 

=SUM(A2:A7, A9, A12:A15) – A sophisticated collection that sums values from range 

A2 to A7, skips A8, adds A9, jumps A10 and A11, then finally adds from A12 to A15. 

=SUM(A2:A8)/20 – Shows you can also turn your function into a formula. 

2. COUNT: It returns the count of numeric values in a cell. You can refer to the cells where 

you have values or simply insert the values into the function [...] 

=COUNT(value1, [value2], …) 

Example: 

COUNT(A:A) – Counts all values that are numerical in A column. However, you must 

adjust the range inside the formula to count rows. 

COUNT(A1:C1) – Now it can count rows 

3. AVERAGE: It returns the average of numeric values in a cell. You can refer to the cells 

where you have values or simply insert the values into the function [...] 

=AVERAGE(number1, [number2], …) 

Example: 

=AVERAGE(B2:B11) – Shows a simple average, also similar to (SUM(B2:B11)/10)  

4. TIME: It returns a valid time serial number as per Excel's time format. You need to specify 

hours, minutes and seconds [...]  

5. DATE: It returns a valid date serial number as per Excel's time format. You need to specify 

day, month and year [...]  

6. LEFT: This function extracts specific characters from the a cell/string starting from the 

left (start). You need to specify the text and number of characters to extract [...] 

7. RIGHT: This function extracts specific characters from the a cell/string starting from the 

right (last). You need to specify the text and number of characters to extract [...]  
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8. VLOOKUP: It looks up for a value in a column and can return that value or a value from 

the correspondent columns using same row number [...]  

9. IF: This function returns a value when the specific condition is TRUE and returns 

another values it condition is FALSE [...] 

 

=IF(logical_test, [value_if_true], [value_if_false]) 

Example: 

=IF(C2<D3, ‘TRUE,’ ‘FALSE’) – Checks if the value at C3 is less than the value at D3. If 

the logic is true, let the cell value be TRUE, else, FALSE 

=IF(SUM(C1:C10) > SUM(D1:D10), SUM(C1:C10), SUM(D1:D10)) – An example of 

a complex IF logic. First, it sums C1 to C10 and D1 to D10, then it compares the sum. If 

the sum of C1 to C10 is greater than the sum of D1 to D10, then it makes the value of a cell 

equal to the sum of C1 to C10. Otherwise, it makes it the SUM of C1 to C10. 
 

10. NOW: It returns the current date and time in the cell where you insert it using your 

system's settings [...] 

Creating Charts 

In Microsoft Excel, you can represent numbers in a chart. On the Insert tab, you can choose 

from a variety of chart types, including column, line, pie, bar, area, and scatter. The basic 

procedure for creating a chart is the same no matter what type of chart you choose. As you 

change your data, your chart will automatically update. 

You select a chart type by choosing an option from the Insert tab's Chart group. After you 

choose a chart type, such as column, line, or bar, you choose a chart sub-type. For example, 

after you choose Column Chart, you can choose to have your chart represented as a two-

dimensional chart, a three-dimensional chart, a cylinder chart, a cone chart, or a pyramid chart. 

There are further sub-types within each of these categories. As you roll your mouse pointer 

over each option, Excel supplies a brief description of each chart sub-type. 

Create a Chart 
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To create the column chart shown above, start by creating the worksheet below exactly as 

shown. 

 

 

 

 

 

 

 

 

 

After you have created the worksheet, you are ready to create your chart. 

Step -1 Create a Column Chart 

 

 

 

 

 

 

 

 

 

1. Select cells A3 to D6. You must select all the cells containing the data you want in your 

chart. You should also include the data labels.  

2. Choose the Insert tab.  

3. Click the Column button in the Charts group. A list of column chart sub-types types 

appears.  

4. Click the Clustered Column chart sub-type. Excel creates a Clustered Column chart and 

the Chart Tools context tabs appear. 

Step-2  Apply a Chart Layout 

Context tabs are tabs that only appear when you need them. Called Chart Tools, there are three 

chart context tabs: Design, Layout, and Format. The tabs become available when you create 

a new chart or when you click on a chart. You can use these tabs to customize your chart. 
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Apply a Chart Layout 

 

 

 

 

 

 

 

 

1. Click your chart. The Chart Tools become available.  

2. Choose the Design tab.  

3. Click the Quick Layout button in the Chart Layout group. A list of chart layouts appears.  

4. Click Layout 5. Excel applies the layout to your chart. 
 

Step-3  Change the Style of a Chart 

A style is a set of formatting options. You can use a style to change the color and format of 

your chart. Excel 2007 has several predefined styles that you can use. They are numbered from 

left to right, starting with 1, which is located in the upper-left corner. 

Change the Style of a Chart 

 

 

 

 

 

 

 

 

 

 

 

 

1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab. 

3. Click the More button  in the Chart Styles group. The chart styles appear.  
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4. Click Style 42. Excel applies the style to your chart.  

Step- 4  Change the Size and Position of a Chart 

When you click a chart, handles appear on the right and left sides, the top and bottom, and the 

corners of the chart. You can drag the handles on the top and bottom of the chart to increase or 

decrease the height of the chart. You can drag the handles on the left and right sides to increase 

or decrease the width of the chart. You can drag the handles on the corners to increase or 

decrease the size of the chart proportionally. You can change the position of a chart by clicking 

on an unused area of the chart and dragging. 

Change the Size and Position of a Chart 
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1. Use the handles to adjust the size of your chart.  

2. Click an unused portion of the chart and drag to position the chart beside the data. 
 

Step-5 Move a Chart to a Chart Sheet 

By default, when you create a chart, Excel embeds the chart in the active worksheet. However, 

you can move a chart to another worksheet or to a chart sheet. A chart sheet is a sheet dedicated 

to a particular chart. By default Excel names each chart sheet sequentially, starting with Chart1. 

You can change the name. 

 

Move a Chart to a Chart Sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Click your chart. The Chart Tools become available.  

2. Choose the Design tab.  

3. Click the Move Chart button in the Location group. The Move Chart dialog box appears.  

 

 

 

 

 



 
BAMC II year     Subject: Information Commination Technology 

 

 

45, Anurag Nagar, Behind Press Complex, Indore (M.P.) Ph.: 4262100, www.rccmindore.com 
44 

 

4. Click the New Sheet radio button.  

5. Type Toy Sales to name the chart sheet. Excel creates a chart sheet named Toy Sales and 

places your chart on it. 
 

Step-6  Change the Chart Type 

Any change you can make to a chart that is embedded in a worksheet, you can also make to a 

chart sheet. For example, you can change the chart type from a column chart to a bar chart. 

Change the Chart Type 

 

 

 

 

 

 

 

 

 

 

 

 

1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab. 

3. Click Change Chart Type in the Type group. The Chart Type dialog box appears. 

4. Click Bar. 

5. Click Clustered Horizontal Cylinder. 

6. Click OK. Excel changes your chart type.  
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Introduction to PowerPoint 

Microsoft PowerPoint is a powerful, easy-to-use slide show presentation program included in the 

Microsoft Office suite. It is used to make presentations for personal and professional purposes 

PowerPoint is a graphical presentation program used to organize and present information. 

PowerPoint presentations consist of a number of individual pages or "slides.” Slides may 

contain text, graphics, sound, movies, and other objects that can be freely arranged. 

Presentations can be printed, displayed live on a computer, or navigated through at the 

command of the presenter. For larger audiences, the presentation is often projected onto a large 

screen. Handouts, speaker notes, or outlines can also be produced from the slides. 

Some Uses of PowerPoint Presentation 

• Education  

• Marketing  

• Business  

• Creating Resumes 

• Depicting Growth 

 

PowerPoint 2016 Editing Window (Normal View) 

The Normal View in PowerPoint features several commonly used Tabs, Panes, and Tools. 

The Ribbon 

The Ribbon replaces the menu bar seen in previous versions of PowerPoint. The Ribbon groups 

items that are most likely to be used together. There are several frequently used tabs, such as 

File, Home, Insert, Design and View. Clicking on each tab activates a group of relative 

commands, menus, and buttons. There are also contextual tabs that only show up only when 

needed, such as Text Box Tools, Picture Tools, Drawing Tools and Chart Tools. To activate 

those tools, click on the associated object. 
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Opening PowerPoint 

To open a PowerPoint 2016 presentation, click on the File tab in the upper left corner. 
 

 

 

 

The most common choices for opening a presentation are: 

• New ‐ allows you to open a Blank presentation or you may choose from a selection 

of Templates and Themes. 

• Open ‐ lets you navigate to an existing file to view and/or modify a presentation 

that has already been created. 

• Recent – displays a list of your most recently created presentations and their file 

locations. 

Creating New Presentations 

The New selection gives you several options: 

 

 

 

 

 

• Blank presentation creates a new presentation using default settings for text and 

color. Theses slides will not include content or design elements. 

• Templates and Themes are used to create a new presentation based on pre‐ 
designed slide styles. These options also do not include content. 

• New from existing will use the formatting of a previously created presentation. 

For this exercise, we’ll start with a Blank presentation. Select New, choose Blank 

presentation and click on the Create icon. 
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PowerPoint Slides  

When you choose to create a blank presentation, PowerPoint will open a presentation with 

a Title Slide. Once the Title Slide is open, you’ll see a slide with two placeholder text 

boxes for a title and a subtitle. Click inside the placeholder box and type to add the title. If 

you want a subtitle, click and type inside the smaller placeholder. If you don’t want a 

subtitle, you can just ignore its placeholder box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To add a New Slide, make sure you’re on the Home tab. The New Slide button will add 

slides to your presentation. 

 

 

 

 

 

 

 

The New Slide button has two parts: 
 

Clicking on the top part will automatically insert a new slide. If you have just 

reated a Title slide, the new default layout will be a Title and Content slide 

(for details, see the section on slide layouts). 
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Clicking on the bottom will give you a choice of layouts. You can choose which 

layout you want for your next slide. Select a slide layout by clicking on its image 

in the Office Theme gallery. 

Slide Layouts 

 

There are several standard slide layouts to 

choose from when adding new slides. 

A unique layout can be chosen by clicking 

on the bottom half of the New Slide button 

in the Home tab. When the layout gallery 

opens, click on the style you want and a new 

slide with that layout will appear in your 

presentation. 

Each layout caption describes the layout 

type. Content can be text, tables, charts, 

graphics, pictures, clip art, or video. 

If you decide later that the layout you chose 

doesn’t work well for a particular slide, 

select the slide by clicking on it in the 

Thumbnail pane. Next, click on the Layout 

button in the Slides group of the Home tab. 

Click on a new layout and it will change the 

layout of the slide. 
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Applying a Theme 

Once a new presentation has been created, a design or color scheme can be added. 

Remember to use color carefully to enhance your presentation, not detract from it. You 

will want to maintain good contrast between the background color and the text color. 

Consider using a light colored background and dark text (or vice versa), but avoid busy 

backgrounds and primary colors. Use sans serif fonts like Arial, Calibri, and Helvetica for 

titles and size them between 44 – 60 points. Sub‐headings should be between 32 – 40 

points, and body text between 18 – 32 points. Try not to use more than two fonts. 

PowerPoint has many pre‐set designs and themes that include complimentary colors and 

fonts. To add a theme to a presentation, go to the Design tab in the ribbon. There are several 

themes immediately available. To use one of the built‐in themes, just click on its thumbnail. 

 

 

 

 

 

On the right side of the Theme thumbnails, there’s a scroll bar and an Arrow Down button, 

which will offer more designs, as seen below. If you’re online, you can get more themes 

from Microsoft Office Online. (Your office program must be a genuine Office product to 

get online templates). 

 

 

 

 

 

 

 

If you don’t want to use a theme, you can add Background Styles. From this selection, 

you can add some preset background styles that change according to the colors you’ve 

chosen. 
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Using the Format Background feature, you can choose fill colors, gradients, 

transparencies, textures, or pictures for your background. 

When you have the desired background fill effect, select Close to apply it to the 

selected slide or choose Apply to All to add the background to all of the slides 

in the presentation. 

Designs can be added to all of the slides or to selected slides. To select multiple 

slides, click on a slide in the Thumbnail pane of the navigation bar and then 

hold down the control key and click on any other slides you want to apply the 

design to. 

 

 

Text 

Formatting Bulleted Lists 

In PowerPoint, you can easily modify a slide’s default bulleted list. Click inside the text box, and 

the Format tab will automatically be highlighted. Click on the drop down triangle next to the Bullets 

button in the Paragraph group. 

 

 

 

 

 

 

 

 

Bullets Drop Down 
 

Button 

 

Text in the form of a bulleted list is the default 

content of this slide layout. To add a bulleted list, just 

Click to add text and start typing.  
 

From the Bullets and Numbering menu you can make various changes to your list: 
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The bullet size relative to the text The color 

of the bullet 

 

The shape of the bullet using either a picture or a 

character 

 

 

 

You may also want to adjust line spacing between 

paragraphs or lists. You can do this through the 

Paragraph group of tools by clicking the Line Spacing 

button and selecting Line Spacing Options. 

 

 

 

 

 

 

 

 

 

 

 

 

Indents and Spacing controls will open in a separate dialog box. 

 

 

 

Adding Content 

Text is the default content of the slide below. The format for the default text is a bulleted list. To add 

text, click and begin typing. To add other content, click on the icon within the content group on the new 

slide. Each icon will open the appropriate dialog box or task pane in the Drawing Tools contextual tab. 
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Drawing Tools 

 

 

 

 

 

 

The icons represent the six standard graphical elements that you might want to insert. 
 

Table Chart SmartArt 

 

Picture Online Video 

Pictures 

Clicking on an icon will open the associated dialog box. Note that these icons, as well as several 

other insertion options, are also displayed in the Insert tab on the Ribbon. 

 

Tables 

 

Set the number of columns and rows as needed in the Insert Table dialog box and click OK. Methods 

for editing and the design and layout of your table are located on the Table Tools contextual tab. 

 

 

 

 

 

 

 

 

Table Tools 
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Charts 

Select the type of chart you want and click OK. Once inserted into the slide, you can click on the 

chart to activate the Chart Tools contextual tab, where you’ll find tools for editing chart data and 

changing layouts and styles. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SmartArt Graphics 

 

SmartArt graphics are shapes that are designed to represent the relationship between things or 

people. You might use SmartArt for an organizational chart or a timeline. SmartArt styles and 

layouts can be formatted in the SmartArt Tools contextual tab. 
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Pictures 

 

Rather than using too much text on your slides, consider using pictures along with text as a more 

interesting way to communicate your ideas. You can put lots of text into the Notes Section and refer 

to that as you’re speaking. 

 

When browsing for images, keep in mind that pictures imported from web sites can be low 

resolution, and are typically used for on‐screen presentations and web pages. If you’re going to print 

handouts, be sure to use images that are at least 180 dpi (dots per inch). 
 

 

 

 

 

 

 

 

 

 

 

 

 

Notes Section  

Online Pictures 

Online pictures have replaced the old Clip Art. When you click on the Online Pictures button you 

get a search box. You can type in a word and press enter to search for a specific image or you can 

click on the Bing Image Search icon to browse categories. 
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Videos / Media 

 
 

You can embed a video or link to a video from your 

presentation. If you want to limit the size of your file, 

you can link to a video file on your local drive or to a 

video file that you uploaded to a web site, such as 

YouTube or Hulu. 

 

All options to insert video or audio are located on 

the Insert tab, in the Media group. 

 

 

 

 

 

Viewing Presentations 

There are four different ways to view your presentation in PowerPoint. The views can be accessed 

using the buttons in the status bar, or by using the View Tab on the Ribbon. 

 

 

 

 

 

Normal View displays a single slide as it appears in the 

presentation, as well as thumbnails and an outline tab, 

where you can organize the structure. Speaker notes 

can be added in the bottom section of this window. This 

view is used to create and edit slides. 
 
 

Slide Sorter View shows thumbnails of your slides. 

From this view you can reorder slides by dragging and 

dropping them, or you can set the timing for the slide 

show. You can also hide slides in this view. Hiding a 

slide will keep it in the file, but it will not show when 

you view the presentation. 
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Notes Page View allows the speaker to create notes to 

use during a presentation. Each page corresponds to 

one slide. These can be printed to assist the presenter 

during the presentation. Use this view when you’re 

composing speaking topics. 

 

 

Reading View/Slide Show View displays the slides as 

an audience will see them. Use the arrows and icons on 

the lower right side of the Status Bar to advance slides 

or switch views. 
 
 

Use the Esc key to return to Normal View. 
 

 

 

Slide Show Tab 

 

The Slide Show Tab allows you to review the slide show from beginning to end or from the 

current (active) slide. You can also control how the show will be presented and rehearse 

timings in the Set Up Slide Show drop down box. 

 

 

 

 

 

Use Presenter View 

lets the speaker 
 

read their notes as 

they present, but 

the audience will 
 

only see the slides. 



 
BAMC II year     Subject: Information Commination Technology 

 

 

45, Anurag Nagar, Behind Press Complex, Indore (M.P.) Ph.: 4262100, www.rccmindore.com 
57 

 

 

Changing the Order of Slides in a Presentation 

 

In the slide sorter view, click and hold down the left mouse button and drag the slide to a new 

location. You’ll see a line where the slide will be placed when you release the mouse button. This 

can also be done in the Thumbnail pane area of the Navigation bar. 

 

Select slide 4 and drag it above slide 3. 

PowerPoint Help 

 

If you need help at any point while you’re creating or presenting a PowerPoint slide show, you 

can press the F1 key on your keyboard to get content‐specific help. 

 

Saving a Presentation 

 

You can save a file by clicking the File tab, choosing Save, typing a descriptive name into the File 

Name window, and then clicking the Save button. 

 

 

 

 You can also use the 

Save  button  on  the 

Quick Access Toolbar 

in the top left corner. 
 

 
 

Save  

 

 

If others will need to open your file with previous versions of PowerPoint, use 

the Save As option and select PowerPoint 97 – 2003 Presentation from the 

Save as type menu. 

 

Save and Send to Others 
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If you need to send your presentation to someone 

else, the best way to is to use the Save & Send option. 

You can send an attachment of your file using Send 

Using E‐ mail, but if you have large media files, such 

as videos, you’ll need to compress those first to make 

a smaller file. On the Home Select the Info tab and 

click the Compress Media button and choose 

Presentation Quality. Note: Only available if you 

have inserted media. 

You also have the option to Package Presentation for CD. This allows you to add other files or to 

add a PowerPoint Viewer so that the presentation can be run on a computer that does not have the 

PowerPoint program. You can also add any linked files such as video or audio. 
 

Printing your Presentation 

PowerPoint offers several print options to help you prepare your presentation. You can print slides, 

handouts, and/or notes to support your presentation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Types of Print Layouts 

Print All Slides prints out the entire presentation, one slide per page, usually landscape. If 

you have color graphics on your slides and a large number of pages to print, you may want 

to print in Grayscale or Pure Black and White. 

Notes Pages will print one slide per page and have room for your presentation notes (if you 

type them in). 

You can print a text outline of your slides with the Outline option. 
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Handouts can be printed with one, two, three, four, six or nine slides per page. When 

printing handouts with multiple slides per page, you also have the option to print the pages 

horizontally or vertically. 

Features of MS PowerPoint 

• Slide Layout 

• Insert – Clipart, Video, Audio, etc. 

• Slide Design 

• Animations 

•  

ANIMATIONS AND TRANSITIONS IN POWERPOINT 

Animations add excitement and pizzazz to your slide show. However, they are easily 

abused. They can be distracting and can actually slow down your show if you use too many. 

Again, judicious use makes all of the difference in the attractiveness of your show. 

You can animate text or objects to grab your audience’s attention. You can also animate the 

transition from one slide to the next. 
 
 

 

 

 

Transition to this Slide 

• Select the Slide Sorter view for your presentation. 

• Click on the Animations tab in the Ribbon. 

• Choose the Transition to this Slide Group. 

• The default animation for every presentation is none. 

• The next animations that display are the most frequently used animations. The drop 
down arrow at the right corner of this group will offer additional options. 

• Select a slide and click on one of the icons. You will see that animation reflected on that 
slide in the Slide Sorter view. 

• If you choose an animation, it will only apply to the slide(s) that you have selected. 

• Click the Apply to all button in the group to apply your selected transition to all of 
your slides. (This is generally recommended to give a cleaner and more professional 
appearance to your show.) 

• You can also apply Transition sounds and change the speed using the additional drop 

down choices in this group. It is recommended that you use Transition Sounds sparingly, 

but they can occasionally add fun to your work.  
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Other options in the tab include the ability to set up how 

the slide show advances during your presentation. – 

Upon a mouse click or pressing the <ENTER> key. - Or 

– You can use the Automatically After and enter the 

time if you have practiced your show and feel 

comfortable with this option. 

Animating text 

One way to animate text is to have your bulleted 
point display one at a time. To do this: 

• Highlight the text box to which you want to  

• apply an animation.  

• Click on the Animations tab in the Ribbon. 

• Choose the Animations group on the left side of the ribbon contents. 

• Click the drop down arrow next to Animate in the group. 

• Choose the type of animation you would like. Each effect will be previewed on the selected slide 

until you make your selection. 

• Click Custom Animation to allow for even more control of your animation selections. The Custom 

Animation task pane opens on the right side of your screen. 

• You can add Entrance or Exit effects 

• You can add text emphasis by size or even spinning in the Emphasis section. 

• Motion Paths allows you to decide from which direction your animations enter or leave the screen.
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Animating Objects 

You can also animate 
also any object that 
you have added to a 
slide. 

 Display the slide in Slide view 

 

 

 

  

  

FIGURE 7    

 

 Click on the 

object in a 

slide to which 

you want o 

apply an 

animating 

effect.  

 Click on the Animations tab  

  In the Animations group, select 

 

FIGUR
E 5 

  

Custom Animation 

 

 Click on the 

Drop down 

arrow in the 

Custom 

Animation 

task pane. 

• F
I
G
U
R
E 
8 
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 Select the type 
of animation 
desired. 

 You will see the path of the chosen animation display on the screen. [Figure 5] 

 If you choose to animate more than one image, each image will have a number 
next to it on the screen. [Figure 6] 

 That number will display in the contents of the task pane on the right side of the screen. 

[Figure 7] 

 To change the order in which objects on you slide display, click on the Up 
arrow next to Re-Order [Figure 8]. 

 

You can also add sound to each object. Simply select the object in the Slide view, 
click on the Animations tab, and click on the drop down arrow next to Transition 
sound in the Transition to this Slide group and select your sound. 

Exiting PowerPoint 

There are several ways to close your file and exit PowerPoint. From the File Button, 

click Close, if you have not saved your presentation, PowerPoint will prompt you to 

save. Click Yes to save your presentation and your changes, click No to discard your 

changes and close the file. 

To close the presentation and exit the program, choose Exit or use the X in the upper 

right corner of the PowerPoint window. You’ll be prompted to save the presentation if 

any changes have not been saved. 

Introduction to Google Docs 

Google Docs, is a free web-based word processor in which documents can be created, edited 

and stored as part of the on Google drive which is a cloud server featured by Google.  

Documents can be imported to any computer with Internet connectivity with a google web 

browser. Google Docs is a part of a comprehensive package of online applications offered by 

Google. 

Google docs is the solution  

• when a lot of information is shuttled to and from multiple points between the same firm  

• when data is added or removed from the content by a number of users.  

Advantages of using Google Docs include: 

• Anytime, anywhere access   
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• Collaboration support  

• Auto save and revision history  

• Shared collections  

• Templates. 

• Easy To Use 

• It can be used with any operating system 

Google Docs Features: 

• Google Docs gives its users the choice to create, edit, update, and import/export 

documents and spreadsheets in several different fonts and file formats while combining 

text with formulas, lists, tables, and images as well. 

• Google Docs is adaptable with almost all presentation software and word processor 

applications for effective processing. 

• The work which is executed on Google Docs can be published as a web page or as a 

print-ready manuscript at any given point in time. 

• Google Docs offers access to those who can view, comment or edit their work. 

• It has become an ideal choice for publishing within an enterprise, organization 

maintaining blogs, or composing work that can be viewed or edited by multiple users 

at one go. 

Powerful tools of Google Docs   

1. Voice recognition rather than typing 

2. Clear formatting 

3. Additional fonts 

4. Suggestion mode 

5. Tag someone in a comment 

6. Bookmark more, scroll less 

7. Offline mode 

8. Rolling down own substitutions 

9. Right-click for research 

10. Revision history 

 

Google Drive  

Google Drive is a free service from Google that allows you to store files online and access 

them anywhere using the cloud. Google Drive also gives you access to free web-based 

applications for creating documents, spreadsheets, presentations, and more. It is not tied to any 

one device or machine. Rather it is accessible from anywhere, including your home computer, 

mobile device, or a public machine at a college or library. This type of storage is also called 

Cloud Storage.  
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• It keeps the files online 

• files can be accessed from any computer with an Internet connection, 

• It eliminates the need to email or save a file to a USB drive 

• It allows you to share files; working with others becomes much easier. 

 

Features of Google Drive  

• 15 gigabytes of free storage. Additional storage is available for a fee.  

• Upload and/or Download capabilities  

• Free desktop publishing software that is available through your Google Drive account. 

o  Google Docs ~ Microsoft Word  

o Google Sheets ~ Microsoft Excel  

o Google Slides ~ Microsoft PowerPoint  

• File sharing - allows other Drive users to view and/or edit files, simultaneously if need 

be.  

How Do I Access Google Drive?  

• If you have a Gmail account, first go to Google.com, click the Gmail link on the top, 

right corner of the page, and then log-in with your username and password. 

• Click the Waffle icon on the top right corner of the page  

Types of files you can create and share on Google Drive: 

•  Documents: For composing letters, flyers, essays, and other text-based files 

(similar to Microsoft Word documents) 

•  Spreadsheets: For storing and organizing information (similar to Microsoft 

Excel workbooks) 

•  Presentations: For creating slideshows (similar to Microsoft PowerPoint 

presentations) 

•  Forms: For collecting and organizing data 

•  Drawings: For creating simple vector graphics or diagrams 

 

Google Forms 

Google Forms allows you to create your own custom online forms and send them to others. 

These forms can include surveys, quizzes, sign-ups, and more. When someone completes the 

form, the responses will be stored in a Google Sheets spreadsheet for you. 
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Things can be done with Google Forms 

Google Forms has several uses, both personal and professional. Let's take a look at several of 

its applications and possibilities. 

• Personal: You can use it to create your own event invitations, gather contact 

information, and find the best time to meet with various people. 

• Work: Smaller businesses can easily use Google Forms to make their own job 

applications, order forms, feedback forms, and more. 

• Education: Teachers can use Google Forms to create quizzes and worksheets for their 

students to complete. 

Steps to create a Google form 

• Form can be created either from scratch or by using a template (Personal, Work, 

and Education). 

• Select a blank form 

• Select a types of questions 

o Short answer: 

o Multiple choice, check boxes, and drop-down lists 

o Linear scale 

o Time or date 

• Choosing how to save your responses 

o Inside the form 

o Using Google Sheets:  

• Adjusting settings 

o Limit to 1 response 

o Collect email addresses 

o Response receipts 

•  sending the form out 

o Sending your form via email 

o Sharing your form with a link 

o Sharing your form via embed 

o Sharing your form via social media 

Google Scholar 

Google Scholar is a search engine that provides links to full-text articles to which the 

Benedictine Library subscribes or to articles made freely available by the publisher. Google 

Scholar also provides articles from academic publishers, professional societies, preprint 

repositories and scholarly articles posted freely on the web. It also provides citations along with 

abstracts of the article if it is protected by copyright. 
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Google Scholar aims to rank documents the way researchers do, weighing the full text of each 

document, where it was published, who it was written by, as well as how often and how recently 

it has been cited in other scholarly literature. 

Google Scholar Features 

• Fast and easy to use 

• Provides a "cited by" feature 

• Provides formatted citations 

• Provides library links 

• Find open access journals 

• Find science and technology articles 

• Find patents and legal documents 

 

Advantages of using Google Scholar: 

• Google Scholar is familiar and relatively simple to use, much like Google. 

• Google Scholar allows users to search for a find a wide variety of materials including 

articles, books, "grey literature" like conference proceedings on a vast number of topics. 

• Google Scholar allows for you to see articles related to the one that might interest you, 

how many times an article has been cited and by whom, and provides citations for 

articles in a number of styles. 

• Google Scholar can display links to articles and books held through ECU Libraries. For 

more information, see Using Google Scholar from Home tab. 

• Google Scholar allows you to save both citations and articles to read later. 

Disadvantages of using Google Scholar: 

• Google Scholar's coverage is wide-ranging but not comprehensive. It can be a research 

source, but should not be the only source you use. 

• Google Scholar does not provide the criteria for what makes its results "scholarly". 

Results are often vary in quality and it is up to the researcher to determine which of the 

results are suitable for their purposes. 

• Google Scholar does not allow users to limit results to either peer reviewed or full text 

materials or by discipline. 

• Google Scholar does not provide notice of when its materials are updated. 

• Google Scholar's citation tracker can be difficult to use and inaccurate. 
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UNIT -4 

Social media refers to the means of interactions among people in which they create, share, 

and/or exchange information and ideas in virtual communities and networks 

These are some of the most popular social media platforms, and each has its own unique 

features and audience. 

1. Facebook: a social networking site where users can connect with friends and share 

posts, photos, and videos. 

2. Twitter: a microblogging site where users share short messages (tweets) and follow 

others. 

3. Instagram: a photo and video sharing site where users can post pictures and short clips, 

and follow others. 

4. LinkedIn: a professional networking site for job seekers, businesses, and employees. 

5. TikTok: a short-video sharing platform where users can create and share 15-second 

videos. 

6. Pinterest: a virtual pinboard where users can share and discover new interests by posting 

images and links related to their hobbies. 

7. Snapchat: a multimedia messaging app where users can send snaps (photos and videos) 

that disappear after being viewed. 

8. YouTube: a video sharing platform where users can upload, share, and view videos. 

BLOG: 

A blog is a website or section of a website where an individual or organization writes about 

topics of interest. It is typically updated regularly with posts and often allows for reader 

comments. 

Social media research tools  

These are some of the most popular social media research tools, and each offers different 

features and capabilities to help you gather insights about your social media presence and the 

online conversation surrounding your brand or industry. Here are some popular social media 

research tools: 
 

1. Google Trends: A tool that provides insights into the popularity of specific search terms 

and topics over time. 

2. Hootsuite Insights: A social media analytics tool that provides insights into the 

performance of your social media posts and accounts, including audience demographics 

and engagement metrics. 

3. BuzzSumo: A tool that allows you to see the most shared content on social media across 

different platforms and topics. 

4. Brand24: A social listening tool that helps you monitor mentions of your brand and 

competitors across the web, including social media. 

5. Keyhole: A real-time social media tracking tool that helps you monitor hashtags, 

keywords, and mentions on social media. 
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6. NetBase Quid: An AI-powered social media analytics platform that helps you analyze 

and interpret large amounts of social data. 

7. Sysomos: A social media analytics platform that provides insights into social media 

conversations, audience behavior, and brand sentiment. 

8. Sprout Social: A social media management and analytics platform that provides insights 

into audience engagement, social media performance, and competitor analysis. 

Twitter Analytics  

It is a free tool provided by Twitter that allows businesses and individuals to track and analyze 

their Twitter account performance. Twitter Analytics can help you make informed decisions 

about your Twitter content strategy and measure the success of your Twitter campaigns. The 

tool provides valuable insights into your audience, the impact of your tweets, and how you can 

improve your Twitter presence. 

With Twitter Analytics, you can: 

1. Track audience growth: Monitor the growth of your Twitter following, including new 

followers and lost followers. 

2. Analyze tweet performance: View the performance of individual tweets, including 

impressions, engagement, and link clicks. 

3. Monitor engagement: Track engagement metrics, including retweets, likes, replies, and 

mentions. 

4. Identify your most engaged followers: See which of your followers are most engaged 

with your tweets and identify potential influencers. 

5. Measure the impact of events: Track the performance of your Twitter activity during 

specific events and see how it affected your reach and engagement. 

6. Compare performance over time: See how your Twitter account is performing over time 

and compare it to previous periods. 

Facebook Analytics 

It is a free tool provided by Facebook that allows businesses and individuals to track and 

analyze their Facebook page performance. With Facebook Analytics, you can: 

1. Track audience growth and engagement: Monitor the growth of your Facebook page 

and the engagement levels of your followers. 

2. Analyze content performance: View the performance of individual posts, including the 

reach and engagement they received. 

3. Monitor ad performance: Track the performance of your Facebook ads and see how 

they are affecting your audience growth and engagement. 

4. Segment audience data: Break down your audience data by demographics, location, and 

interests to gain deeper insights into your target audience. 

5. Compare performance over time: See how your Facebook page is performing over time 

and compare it to previous periods. 

6. Facebook Analytics can help you make informed decisions about your Facebook page 

and content strategy, as well as measure the success of your advertising campaigns. 
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YouTube Analytics 

YouTube Analytics is a tool provided by YouTube that allows users to view and analyze 

metrics related to their YouTube channel and videos. It provides information on viewer 

engagement, audience demographics, traffic sources, and more. You can use YouTube 

Analytics to monitor the performance of your videos and optimize your content for greater 

engagement and growth on the platform. 

YouTube Analytics can be used to: 

1. Track and measure the performance of your videos, including views, engagement, and 

audience retention. 

2. Analyze audience demographics, such as age, gender, location, and interests. 

3. Monitor traffic sources to see how viewers are finding your videos and channel. 

4. Track the engagement of your subscribers, including comments, likes, and shares. 

5. Compare the performance of different videos and understand what content resonates 

with your audience. 

6. Optimize your video content and channel strategy based on the insights gained from 

YouTube Analytics. 

7. Improve your overall presence on YouTube and grow your audience. 

 

Instagram Business Tool 

Instagram Business Tool is a suite of features and tools provided by Instagram for 

businesses to manage their presence on the platform and advertise to their target audience. 

The Business Tool also provides businesses with tools to manage their online reputation 

and customer engagement, such as the ability to respond to comments and messages, and 

access to a range of creative tools for creating eye-catching content. 

The Business Tool includes: 

• Business profile: A dedicated profile that displays information about the business, 

such as contact information and location. 

• Insights: Analytics on the performance of your posts and stories, including reach, 

engagement, and audience demographics. 

• Adverts: The ability to create and run ads on Instagram, including photo and video 

ads, carousel ads, and story ads. 

• Shop: A feature that allows businesses to sell products directly through their 

Instagram profile. 

• IGTV: The ability to upload and share longer-form video content on Instagram. 

Search Engine 

A search engine is a software program or script available through the Internet that searches 

documents and files for keywords and returns the results of any files containing those 

keywords. Today, there are thousands of different search engines available on the Internet, each 

with their own abilities and features. The first search engine ever developed is 

considered Archie, which was used to search for FTP files and the first text-based search 
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engine is considered Veronica. Today, the most popular and well-known search engine 

is Google. Other popular search engines include AOL, Ask.com, Baidu, Bing and Yahoo. 

Search engines are classified into the following categories based on how it works. 

1. Crawler based search engines 

2. Human powered directories 

 

1. Crawler Based Search Engines 

All crawler-based search engines use a crawler or bot or spider for crawling and indexing new 

content to the search database. There are four basic steps, every crawler-based search engines 

follow before displaying any sites in the search results. 

• Crawling 

• Indexing 

• Calculating Relevancy 

• Retrieving the Result 

 

Crawling - Search engines crawl the whole web to fetch the web pages available. A piece of 

software called crawler or botor spider, performs the crawling of the entire web. The crawling 

frequency depends on the search engine and it may take few days between crawls. This is the 

reason sometimes you can see your old or deleted page content is showing in the search results. 

The search results will show the new updated content, once the search engines crawl your site 

again. 

Indexing - Indexing is next step after crawling which is a process of identifying the words and 

expressions that best describe the page. The identified words are referred as keywords and the 

page is assigned to the identified keywords. Sometimes when the crawler does not understand 

the meaning of your page, your site may rank lower on the search results. Here you need 

to optimize your pages for search engine crawlers to make sure the content is easily 

understandable. Once the crawlers pickup correct keywords your page will be assigned to those 

keywords and rank high on search results. 

Calculating Relevancy - Search engine compares the search string in the search request with 

the indexed pages from the database. Since it is likely that more than one page contains the 

search string, search engine starts calculating the relevancy of each of the pages in its index 

with the search string. 

There are various algorithms to calculate relevancy. Each of these algorithms has different 

relative weights for common factors like keyword density, links, or meta tags. That is why 

different search engines give different search results pages for the same search string. It is a 

known fact that all major search engines periodically change their algorithms. If you want to 

keep your site at the top, you also need to adapt your pages to the latest changes. This is one 

reason to devote permanent efforts to SEO, if you like to be at the top. 

 

Retrieving Results - The last step in search engines’ activity is retrieving the results. Basically, 

it is simply displaying them in the browser in an order. Search engines sort the endless pages 

of search results in the order of most relevant to the least relevant sites. 

 

Examples of Crawler Based Search Engines 
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Most of the popular search engines are crawler-based search engines and use the above 

technology to display search results. Example of crawler-based search engines: 

• Google 

• Bing 

• Yahoo! 

• Baidu 

• Yandex 

Besides these popular search engines there are many other crawler-based search engines 

available like DuckDuckGo, AOL and Ask. 

2. Human Powered Directories  

Human powered directories also referred as open directory system depends on human based 

activities for listings. Below is how the indexing in human powered directories work: 

• Site owner submits a short description of the site to the directory along with category it is to be 

listed. 

• Submitted site is then manually reviewed and added in the appropriate category or rejected for 

listing. 

• Keywords entered in a search box will be matched with the description of the sites. This means 

the changes made to the content of a web pages are not taken into consideration as it is only 

the description that matters. 

• A good site with good content is more likely to be reviewed for free compared to a site with 

poor content. 

Yahoo! Directory and DMOZ were perfect examples of human powered directories. 

Unfortunately, automated search engines like Google, wiped out all those human powered 

directory style search engines out of the web. 

 

Search engine as a research tool 

A search engine is a valuable tool for conducting research as they provide quick and easy access 

to a vast amount of information on a wide range of topics in the following ways: 

1. Finding relevant information: Search engines can be used to quickly find information 

on a wide range of topics, including academic research, news articles, and other sources 

of information. 

2. Keyword searching: Search engines allow you to search for specific keywords and 

phrases, making it easier to find relevant information on a specific topic. 

3. Filtering results: Search engines often allow you to refine your search results by date, 

location, or type of content, making it easier to find the information you need. 

4. Evaluating sources: Search engines can be used to assess the credibility and reliability 

of sources by checking the author, publication date, and the website hosting the 

information. 

5. Multidisciplinary research: Search engines allow you to search across multiple 

disciplines and subjects, making it easier to find interdisciplinary information. 

6. Keeping up to date: Search engines can be used to stay informed on current events and 

recent research in a particular field. 
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SEO stands for Search Engine Optimization, 

SEO stands for Search Engine Optimization, which is the practice of increasing the quantity 

and quality of traffic to your website through organic search engine results.  

Let’s break that definition down and look at the parts:  

• Quality of traffic. You can attract all the visitors in the world, but if they're coming to your 

site because Google tells them you're a resource for Apple computers when really you're a 

farmer selling apples, that is not quality traffic. Instead you want to attract visitors who are 

genuinely interested in products that you offer.  

• Quantity of traffic. Once you have the right people clicking through from those search engine 

results pages (SERPs), more traffic is better. Organic results. Ads make up a significant portion 

of many SERPs. Organic traffic is any traffic that you don't have to pay for.  

How SEO works  

You might think of a search engine as a website you visit to type (or speak) a question into a 

box and Google, Yahoo!, Bing, or whatever search engine you're using magically replies with 

a long list of links to webpages that could potentially answer your question. That's true. But 

have you ever stopped to consider what's behind those magical lists of links? Here's how it 

works: Google (or any search engine you're using) has a crawler that goes out and gathers 

information about all the content they can find on the Internet. The crawlers bring all those 1s 

and 0s back to the search engine to build an index. That index is then fed through an algorithm 

that tries to match all that data with your query. There are a lot of factors that go into a search 

engine's algorithm, and here's how a group of experts ranked their importance: 
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That's all the SE (search engine) of SEO.  

The O part of SEO—optimization—is where the people who write all that content and put it 

on their sites are gussying that content and those sites up so search engines will be able to 

understand what they're seeing, and the users who arrive via search will like what they see. 

Optimization can take many forms. It's everything from making sure the title tags and meta 

descriptions are both informative and the right length to pointing internal links at pages you're 

proud of. 

 

Social Media Optimization 

Social Media Optimization (SMO) encourages businesses to assess, monitor, and alter their 

content to conform to social media best practices. All kinds of businesses prefer building their 

social media presence by putting content on platforms like Facebook, Instagram, Twitter, etc. 

Social media optimization is the purposeful creation, development, and optimization of a social 

media marketing plan to communicate with the target demographic. 

SMO is one of the leading digital marketing strategies of the Social Media world. SMO 

primarily focuses on attracting web visitors from sources other than search engines. SMO 

allows SMM (social media marketing) initiatives to operate better by improving content, 

similar to how SEO supports higher search engine rankings. It may also implement online 

reputation management (ORM). If someone submits unfavorable reviews about a firm, an SMO 

strategy can ensure that the negative reviews are not the first link to show in a search engine. 

Social Media Optimization Strategies 

• Content Strategy 

• Optimizing Your Profile 

• Adding a Social Media Badge to Your Website 

• Connecting With Influencers 

• Joining Relevant Social Media Sites 

Search Engine Marketing 

Search Engine Marketing (SEM) is the process of gaining market online by purchasing Ads on 

search engines, say Google, Yahoo, or Bing. SEM involves the promotion of websites by 

increasing their visibility in Search Engine Result Page  

Search Marketing Approaches 

Search marketing works with two approaches − 

 

• Earning traffic through unpaid or free search listings (SEO Methods) 

• Buying traffic through paid search listings (PPC Ads) 
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UNIT -5 

Introduction to info graphics 

An info graphic is a collection of imagery, data visualizations like pie charts and bar graphs, 

and minimal text that gives an easy-to-understand overview of a topic. Infographics use 

striking, engaging visuals to communicate information quickly and clearly. 

Infographics are a valuable tool for visual communication. The most visually unique, creative 

infographics are often the most effective because they grab our attention and don’t let go. 

When you need to give someone a really quick rundown on something that can be hard to 

explain in words alone, an infographic is a good way to go. 

Why infographics? 

Infographics are great for making complex information easy to digest. They can be helpful 

anytime you want to: 

• Provide a quick overview of a topic 

• Explain a complex process 

• Display research findings or survey data 

• Summarize a long blog post or report 

• Compare and contrast multiple options 

• Raise awareness about an issue or cause 

Info graphics can be useful in many industries some of them 

• Infographics for marketing 

• Infographics for consulting and freelancing 

• Infographics for small businesses and entrepreneurs 

• Infographics for government 

• Infographics for nonprofits 

• Infographics for education 

Visual Elements of info graphics 

• Visual 

o Color Coding 

o Graphics 

o Reference Icons 

o Font 

o Alignment, Margins and Spacing 
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• Content 

o Time Frames 

o Statistics 

o References 

o Laws of Hierarchy 

o Descriptive Title and Subheads 

o Clearly Organized, Sequential Story 

• Knowledge 

o Facts 

o Deductions  

o Specially Formatted Facts 

 

 

 

The statistical infographic is infographic type that you can use 

to enhance your content strategy and engage with your audience. 

A statistical infographic is an infographic that includes pie charts, 

bar graphs, and any other visual representations of data. 

• It is to present data and stats.  

• It can be used to present survey results or research.  

 

Informational infographics, for example, are typically more text-heavy than 

the other types of infographics. These are handy to have as visual references 

for topics that are new and unfamiliar. 

    
 

Types of 
infographics:

• Statistical
• Informational
• Timeline
• Process
• Geographic
• Comparison
• Hierarchical
• List
• Resume
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Timeline infographics are one of the best ways to 

make complex information more interesting, 

digestible and easier to follow. You can create the 

following timelines: 

• Project timelines,  

• Historical timelines,  

• Process timelines,  

• Employee onboarding timelines,  

• Event planning timelines, etc. 

 

Process infographics is to summarize a complex process, or break one 

down into clear, concise steps for others to follow They’re perfect for 

visualizing marketing strategies, new employee onboarding, customer 

journey maps, product guides, recipes and more. 

 

 

A comparison infographic is a visual way to compare 

and contrast different options. By presenting two or more 

alternatives side-by-side, this type of infographic helps 

readers understand the distinction between various 

concepts and, in many cases, choose which option is best 

for them. 

 

A Geographic infographic, as you may have guessed 

already, is a graphic that visually communicates information 

in relation to a geographic area. It’s usually presented in the 

form of a map, whether it’s a world map or a map depicting a 

specific country or region. It can be used for a variety of 

purposes. People tend to use them when they want to 

communicate demographic data or other location-specific 

information. 
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A resume infographic graphically represents your work experience 

and skillset in any field. It is a lot better than a traditional resume where 

you only write the plain text that makes your skills look average. With 

an infographic resume template, you can get creative and use charts, 

icons, and timelines to depict your area of expertise. When you create a 

resume, you usually think about what to add and how much information 

you should give to the reader. Still, with an infographic resume, even if 

you don't have any notable achievements, you can make your 

qualification look brilliant by being creative. 

 

The list infographic  is straightforward and perfect for 

beginners. It can be used to summarize points in a presentation, 

a course or a webinar. When designing infographics, remember 

that it should be faster to read and It should be more memorable. 

It’s full of written copy, but it's also highly visual. Like other 

kinds of graphics, it's eye-catching and typically includes a wide 

range of design elements 

 

Hierarchical infographic template helps to visualize content that 

goes from smallest to biggest or most important to least important and 

vice versa. Hierarchical infographic templates can also showcase time 

intervals and tasks that need to be done yearly, monthly and weekly. 

 

Process of creating an infographic 
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Info graphics tools 

Infographic 

Tool 

With the Free 

Version You Get: 

With the Paid 

Version You Get: 

The Free Version 

Is Best For… 

It’s Time to 

Upgrade When… 

#1: Google 

Charts 

20+ chart varieties 

Pre-built HTML 

code 

— Someone who 

knows HTML 

— 

#2: 

Infogram 

Single charts & 

infographic report 

layouts 

Social media post 

layouts 

Data analytics features 

Premium report 

layouts 

Someone who 

needs a basic 

infographic report 

& social media 

templates 

You need data 

analytics 

#3: 

Piktochart 

600+ templates for 

infographics, 

presentations, and 

printables 

& 100 MB storage 

for images 

1G image storage 

HD/PDF exports 

Watermark removal 

Team collaboration 

features 

A small business 

owner new to 

infographics 

You’ve built a 

team that needs to 

collaborate on 

design 

Define Your Audience

Define Your Goals

Gather Your 
Information

Choose a Type of 
Infographic

Create a Logical 
Hierarchy in Your Data

Pick and Customize an 
Infographic Template 

That Fits Your Message

Download, share or 
embed your 
infographic
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#4: Visme Variety of 

templates in key 

business categories 

Social & web 

graphics 

for projects 

Extra media storage 

500,000+ photos and 

10,000+ vectors for 

editorial/commercial 

use 

Unlimited projects 

(business plans) 

A small business 

owner with less 

than five 

infographic 

projects per year 

You and your 

team need to 

collaborate on 

many dynamic 

infographic 

projects regularly 

#5: Easel.ly Limited number of 

infographic layouts 

& charts 

Limited media 

library 

Private storage of 

infographics 

320+ layouts 

Someone who 

needs a simple 

infographic fast 

You know you 

like the service 

and need an 

affordable 

infographic tool 

#6: Canva Extensive tutorials 

Wide variety of 

free project layouts 

Team functions 

Upload/save brand-

specific elements 

Someone who is 

interested in 

learning graphic 

design to create 

projects for their 

business 

You need team 

functions, more 

storage, and richer 

layouts 

#7: 

Venngage 

Save five 

infographics 

Access five layouts 

Add multiple pages to 

infographics 

Custom templates 

A small business 

owner with very 

few infographic 

needs 

You know you 

like the service 

and need 

infographics 

branded for your 

business/HQ files 

#8: 

BeFunky 

Photo editor and 

collage maker with 

an infographic 

designer 

Basic layouts and 

elements to add to 

designs 

More layouts 

Advanced designing 

and editing tools 

Someone with 

photo editing 

needs in addition 

to their infographic 

design needs 

You need 

advanced editing 

tools and more 

than just basic 

layouts and 

graphics 

#9: 

Animaker 

2 minute videos 

Standard quality 

video 

100 exports per month 

(business plan) 

Commercial video 

rights 

Someone who 

wants to make 

short, simple 

infographics 

You need 

commercial rights 

to longer video 

presentations 

#10: Mind 

the Graph 

A blank template 

Upload 1 image 

Start from templates 

Create presentations 

When you just 

need a quick slide 

You’re in a data-

heavy business 

and want 

specialized layout 

options to present 

information 

#11: 

Snappa 

Five downloads a 

month 

Access to 5,000+ 

layouts and 

600,000+ photos 

Team collaboration 

(team plan) 

Upload custom fonts 

You’re a start-up 

owner who needs 

high quality 

graphics each 

month (less than 

five) 

You need a team 

to help you design 

graphics 
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#12: 

PicMonkey 

One week free trial Access to all tools and 

features (more storage 

for Pro plan) 

You want access to 

a full service for 

free 

You need 

infographics 

regularly 

 

 

*************** 


